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CHAPTER

1

Overview of Cisco WebEx Meetings
Cisco WebEx Meetings provides you with tools that help you collaborate with your contacts and colleagues
efficiently. Here are highlights of what you can do:
• Select Meet Now to start an instant meeting.
• Select Schedule to schedule a meeting.
• Join a meeting from your invitation email message or from the Meetings page on your WebEx site.
• Select Recordings to find a meeting recording.
• Use the WebEx Productivity Tools, which lets you schedule, start, and join meetings from Microsoft
Outlook and WebEx Assistant, without the need to use your WebEx site.
If you haven't downloaded the Productivity Tools when activating your account, you can select
Downloads on the top-right portion of your WebEx site and then download it from the page.
To ensure the best possible meetings experience, download the latest releases of Java software for your
favorite web browser. For further assistance, contact your administrator.
• When you are away from your computer, you can schedule, start, and join meetings on your Apple or
Android mobile device. For more information, see the Frequently Asked Questions section.
• Join PCN and Blast Dial meetings at the touch of a button using your Apple or Android mobile device.
Optionally, you can join a web conference.

Note

Make sure that you enable cookies in your browser. You cannot sign in to your WebEx site if cookies in
your browser are disabled.
• Licensing Information, page 2
• Setting Your Instant Meeting Preferences, page 2
• Updating Your Account Information, page 2
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Licensing Information
• Third-Party License and Notices (including free and open-source software)
• End-User License Agreement
• Supplemental End-User License Agreement

Setting Your Instant Meeting Preferences
An instant meeting is a meeting that you can start right away without scheduling in advance. Complete this
task to set your default instant meeting preferences.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select My Account in the top right corner.
Navigate to the Meet Now Settings section.
Enter the requested information.
Note
If you enter a password the system will require users to enter this password whenever they join your
instant meeting.
Select Update.
Note

Step 2
Step 3
Step 4

Step 5

Related Topics
Overview of Cisco WebEx Meetings, on page 1

Updating Your Account Information
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select My Account in the top right.
The My Account page appears.
Note

Step 2
Step 3

Enter the requested information keeping the following notes in mind:
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• Fields with an asterisk (*) are required.
• You cannot change the full name or email address if your system is configured for single sign-on (SSO),
LDAP authentication, or manual profiles.
• Meet Now settings determine your default settings when you start an instant meeting.
• Contact your administrator if you need details about your system configuration.
Step 4

Select Update when finished.
Note
Make sure that you select Update before clicking off the My Account page. Otherwise, any updates
you made will be lost.

Related Topics
Overview of Cisco WebEx Meetings, on page 1
Modifying the Enter and Exit Tones for Your Meeting
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Signing In to WebEx Assistant
Use WebEx Assistant to quickly start or schedule meetings, and set up or change your WebEx account
settings without going to your Cisco WebEx site.
• Signing In to WebEx Assistant, page 5
• Signing In to WebEx Assistant Using Single Sign-On, page 6
• Signing In to WebEx Assistant Using LDAP, page 7
• Switching Sites, page 8
• Starting an Instant Meeting with WebEx Assistant, page 8
• Scheduling a Meeting with WebEx Assistant, page 9
• Scheduling a Personal Conference Meeting with WebEx Assistant, page 10
• Installing WebEx Productivity Tools, page 11
• Setting Up WebEx Productivity Tools, page 12
• Uninstalling WebEx Productivity Tools, page 12

Signing In to WebEx Assistant
Before You Begin
Make sure that WebEx Productivity Tools is installed. Your administrator might have "pushed" this application
to you. If not, you can download it from the Downloads page on your WebEx site.
The Productivity Tools download page also displays instructions for signing in to Productivity Tools. Make
note of the URL because you will need it for signing in to WebEx Assistant.

Procedure
Step 1

From the Start menu, select Programs > WebEx > Productivity Tools > WebEx Assistant.
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The WebEx Assistant dialog box displays. If you previously signed in to WebEx Assistant, the WebEx site
URL you were using is displayed in the Current site is field at the top of the dialog box.
Step 2

(Optional) If you used the Mozilla FireFox or Google Chrome browsers to access your Cisco WebEx site
and download Productivity Tools, do one of the following:
• Enter your on-premises Cisco WebEx Meetings Server site URL and select Next.
• Select Sign in to WebEx in the cloud to sign in to a Cisco WebEx site in the cloud, such as a Cisco
WebEx Meetings or a WebEx centers site.

Step 3

(Optional) Select the Pencil icon next to the Current site field to switch to a different WebEx site. To enter
a new WebEx site URL, do one of the following:
• Enter an on-premises Cisco WebEx Meetings Server site URL and select Next.
• Select Sign in to WebEx in the cloud to sign in to a Cisco WebEx site in the cloud, such as a Cisco
WebEx Meetings or a WebEx centers site.

Step 4

Enter the email address and password for your WebEx account.
• For LDAP Cisco WebEx sites, enter your company email address and password.
• For Single Sign-On (SSO) Cisco WebEx sites, your company sign-in dialog displays for you to enter
your username and password.

Step 5
Step 6
Step 7

Step 8

(Optional) Select Remember me if you want the system to remember your sign-in credentials. Select
Automatically sign in if you want to remain signed in to WebEx Assistant.
Select Sign In.
To determine which WebEx site you are signed in to:
a) Right-click the WebEx Assistant icon on the taskbar and select WebEx Settings....
b) Select the Account tab.
The Account Information section displays the WebEx site you are signed in to. Some Cisco WebEx sites
let you change your password or switch to a different Cisco WebEx site from the Account tab. If you make
changes, select Refresh to update the displayed information.
To sign out of WebEx Assistant, right-click the WebEx Assistant icon on the taskbar and select Sign Out.

Signing In to WebEx Assistant Using Single Sign-On
Typically you sign in to your WebEx site using your email address and password. However, if your
administrator requires that you use single sign-on—that is, sign in through your corporate website, you use a
different sign-in process, provided by your company.

Before You Begin
Make sure that WebEx Productivity Tools are installed. Your administrator may have "pushed" this application
out to you. If not, you can download it from the Downloads page on your WebEx site.
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The Productivity Tools download page also displays instructions for signing in to the Productivity Tools.
Take a note of the URL because you will need it for signing in to WebEx Assistant.

Procedure
Step 1

Do one of the following:
• Select Sign in using single sign-on.
If you don't see the option, enter the email address associated with your WebEx account. Once the system
verifies that you can use single sign-on, the option appears.
• Select Sign in using corporate website.

Step 2

Enter the URL for your WebEx site.
You are redirected to your corporate website.

Step 3

Enter the required information to sign in on the page.

Signing In to WebEx Assistant Using LDAP
When LDAP is enabled for your Cisco WebEx Meetings Server site, you enter your company email address
and password to sign in to WebEx Assistant.

Procedure
Step 1

From the Start menu, select Programs > WebEx > Productivity Tools > WebEx Assistant.
The WebEx Assistant dialog box displays. If you previously signed in to WebEx Assistant, the WebEx site
URL you were using is displayed in the Current site is field at the top of the dialog box.

Step 2

(Optional) If you used the Mozilla FireFox or Google Chrome browsers to access your Cisco WebEx site
and download Productivity Tools, do one of the following:
• Enter your on-premises Cisco WebEx Meetings Server site URL and select Next.
• Select Sign in to WebEx in the cloud to sign in to a Cisco WebEx site in the cloud, such as a Cisco
WebEx Meetings or a WebEx centers site.

Step 3

(Optional) Select the Pencil icon next to the Current site field to switch to a different WebEx site. To enter
a new WebEx site URL, do one of the following:
• Enter an on-premises Cisco WebEx Meetings Server site URL and select Next.
• Select Sign in to WebEx in the cloud to sign in to a Cisco WebEx site in the cloud, such as a Cisco
WebEx Meetings or a WebEx centers site.

Step 4
Step 5
Step 6

Enter your company email address and password.
Select Sign In.
To determine which WebEx site you are singed in to:
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a) Right-click the WebEx ball icon in the system tray and choose WebEx Settings....
b) Select the Account tab.
The Account Information section displays the WebEx site you are signed in to. Notice that you cannot
change your password for a Cisco WebEx Meetings Server site using LDAP sign-in.

Switching Sites
This task describes how to switch between multiple Cisco WebEx sites.

Before You Begin
• To use the Switch Site feature, make sure you have an account on at least one Cisco WebEx Meetings
Server site and one Cisco WebEx site in the cloud, or multiple accounts on Cisco WebEx sites in the
cloud. Note that your WebEx accounts must be local accounts.
• The email address and password assigned for a Cisco WebEx Meetings Server site must match at least
one Cisco WebEx site in the cloud.
• Switch Site is only available if your administrator has enabled the Cloud feature to allow users to sign
in the Cisco WebEx in the cloud accounts from WebEx Productivity Tools.

Procedure
Step 1

Sign in to WebEx Assistant using a multi-site account.
The WebEx Assistant dialog box displays.

Step 2

Right-click the WebEx Assistant icon in the taskbar and select Switch Site...
The available sites display on the WebEx Assistant dialog box. The Cisco WebEx site you are currently using
is listed as Signed in.

Step 3

Select Sign in next to the site you want to use.
Depending on the selected site, you may be required to temporarily close Microsoft Outlook to complete the
switch.
Note

If required, enter a password, and then select Sign
in.

Starting an Instant Meeting with WebEx Assistant
Tip

Once you are signed in to WebEx Assistant, you can start an instant meeting by selecting Meet Now from
the WebEx Assistant icon on the taskbar or the WebEx toolbar in Microsoft Outlook.
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Before You Begin
• Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed"
the WebEx Productivity Tools to your desktop.
• Sign in to WebEx Assistant.
• On the Meetings tab of the WebEx Settings dialog box, you can select the Let me change the meeting
topic and password when the meeting starts check box if you want to override the topic (What) or
password Meet Now settings for each instant meeting.

Procedure
Step 1

Right-click the WebEx Assistant icon on the taskbar and select Meet Now.
Depending on your WebEx Settings, a dialog box requesting meeting-specific information or the Quick Start
page appears.

Step 2

(Optional) If you checked the Let me change the meeting topic and password when the meeting starts
check box on the WebEx Setting dialog box, enter a topic in the What field and a one-time meeting password
for this instant meeting. Then select Meet Now.
The Quick Start page appears.

Step 3

There are two ways to invite people to join your meeting:
• The Meet Now function sends an email invitation for you to forward to invitees.
• Select Invite & Remind on the Quick Start page. On the Email tab, enter the email addresses for
invitees, and then select Send.

Scheduling a Meeting with WebEx Assistant
Before You Begin
• Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed"
the WebEx Productivity Tools to your desktop.
• Sign in to WebEx Assistant.

Procedure
Step 1

Right-click the WebEx Assistant icon on the taskbar and select Schedule a Meeting.
A Microsoft Outlook appointment form opens. If you haven't installed Outlook, WebEx will open the schedule
meeting page.

Step 2
Step 3

Enter your meeting details, such as the meeting subject, start and end times, and invitees.
Select Add WebEx Meeting from the WebEx toolbar.
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The WebEx Settings dialog box appears.
Step 4
Step 5
Step 6
Step 7

(Optional) If you want to include a meeting password, enter it in the Meeting Information section.
If you want to grant other users the permission to start your meeting on your behalf, select the Alternate Host
tab and select them from the list.
Select OK to close the WebEx Settings dialog box.
WebEx information displays in your Microsoft Outlook appointment form.
Select Send to save your meeting information and send updates to invitees.

Scheduling a Personal Conference Meeting with WebEx
Assistant
Before You Begin
• Make sure WebEx Productivity Tools is installed on your desktop. Your administrator may have "pushed"
the WebEx Productivity Tools to your desktop.
• Sign in to WebEx Assistant.
• You cannot assign an Alternate Host for a Personal Conference meeting.

Procedure
Step 1

Right-click the WebEx Assistant icon on the taskbar and select Schedule a Meeting.
A Microsoft Outlook appointment form opens. If you haven't installed Microsoft Outlook, WebEx will open
the schedule meeting page.

Step 2
Step 3

Enter your meeting details, such as the meeting subject, start and end times, and invitees.
Select Add WebEx Meeting from the WebEx toolbar.
The WebEx Settings dialog box appears.

Step 4
Step 5

On the Audio Conference tab, select either WebEx Audio or a Personal Conference account.
(Optional) If you select Personal Conferencing as your Audio Connection before you create a host PIN and
Personal Conference account, the system asks you to do the following:
a) Select View Audio Options on the Personal Conference Account Required message box. If you select
Cancel, the Audio Connection setting returns to WebEx Audio and you can continue to schedule a WebEx
Audio meeting.
b) On the My Account page, go to the My Audio Connection Options section.
c) Select Personal Conferencing.
d) Enter a 4-digit host PIN.
e) Select Save PIN and Generate Account.
f) On the WebEx Settings dialog box, select Cancel to close the dialog box.
g) Close the Microsoft Outlook appointment form.
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h) Return to Step 1 to schedule the Personal Conference meeting again.
Step 6

Select OK to close the WebEx Settings dialog box.
WebEx information displays in your Microsoft Outlook appointment form.

Step 7

Select Send to save your meeting information and send meeting invitations to invitees.
The scheduled meeting displays in your Outlook calendar and the list of meetings on your Cisco WebEx site.

Installing WebEx Productivity Tools
Before installing WebEx Productivity Tools, ensure that your computer meets the following minimum system
requirements:
• Intel Core2 Duo CPU 2.XXX GHz or AMD processor (2GB of RAM recommended)
• JavaScript and cookies enabled in the browser
• Supported operating systems and browsers

Note

For the latest end-user system requirements, including supported operating systems and browsers, see the
Cisco WebEx Meetings Server Planning Guide and System Requirements.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
In the top navigation, select Downloads.
Note
The Downloads option is only available if your administrator has enabled
it.
Under Productivity Tools, select Download.
The File Download dialog box appears.
Note

Step 2

Step 3
Step 4
Step 5

(Optional) Save the installation program (with the extension .msi) to your computer.
Run the installation file and follow the instructions.
After the installation completes, sign in to your WebEx account when prompted, and check your settings in
the WebEx Settings dialog box.

Step 6

(Optional) If the download does not start automatically, select the click here to download link. Run the
installation file and follow the instructions.
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Setting Up WebEx Productivity Tools
Procedure
Step 1
Step 2

Open the WebEx Settings dialog box.
Select the Account tab.
From this tab, you can do the following:
• Select Change password to update your WebEx password.
• Select Update Regional Preferences to update your time zone, language, or locale.
Note
The Time Zone setting is used to determine the time for a scheduled WebEx meeting, and
Locale localizes meeting details such as the format of the date and phone numbers.
• Select Refresh to see the most recent changes to your WebEx site.

Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Select Apply to apply any changes.
Select the Meetings tab.
Select Set meeting preferences to define your default settings for meetings you start instantly from Microsoft
Outlook.
Select Update to save your changes, and then return to the WebEx Settings dialog box.
(Optional) If you want the option to change your meeting topic and password before your instant meeting
starts, check the provided option.
Select OK to close the WebEx Settings dialog box.

Uninstalling WebEx Productivity Tools
This task describes how to uninstall WebEx Productivity Tools from the Windows Start menu. You can
uninstall Productivity Tools at any time. Uninstalling Productivity Tools removes all Productivity Tools and
shortcuts from your computer.

Tip

You can also uninstall Productivity Tools from the Windows Add/Remove Programs option.

Procedure
Step 1
Step 2

Click Start > Programs> WebEx > Productivity Tools > Uninstall.
Click Yes to confirm that you want to uninstall WebEx Productivity Tools.
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Selecting Audio and Meet Now Options
Before you schedule or start your first meeting, go to My Account and configure your audio options. The
My Audio Connection Options and Meet Now Settings appear as the default options when you schedule
all your meetings. You can change the type of audio connection and meet now settings when you schedule
your meeting.
• About Using WebEx Audio, page 13
• Connecting to an Audio Conference, page 14
• Using Your Phone to Connect to Audio, page 15
• Leaving an Audio Conference, page 16
• Using Your Computer to Connect to Audio, page 16
• Fine-Tuning Your Microphone and Speaker Settings, page 17
• Switching Audio Devices During a Meeting, page 17
• Muting and Unmuting Microphones, page 18
• Editing or Updating Your Stored Phone Numbers, page 19
• About Using Personal Conferencing, page 19
• Creating Your Personal Conference Account, page 22
• Dialing In to a Personal Conference Meeting, page 23
• Regenerating Access Codes, page 24
• Deleting a Personal Conference Account, page 25

About Using WebEx Audio
WebEx Audio lets you use either your phone or your computer to hear others and to speak in your meeting:
• Phone—you can use your phone to receive a call to the audio portion of the meeting or to dial in.
• Computer—you can use a headset connected to your computer to join the audio portion of the meeting
if the computer has a supported sound card and a connection to the Internet.
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Note

If you are a host, the number of people to participate in the audio conference depends on the size of your
system.
After joining the conference, participants can switch between audio modes with little or no listening interruption.
In a mixed-mode conference, where some participants are using the telephone and others are using the computer,
all participants can speak.
Your role in an audio conference determines your level of participation. Whichever role you take, the following
table describes the basic tasks you can accomplish in that role.
Role in Audio Conference

Task Description

Host an audio conference

• Join or leave the audio conference
• Switch audio connection modes
• Mute or unmute one or more microphones
• Use caller authentication to join the conference
• Edit or update phone numbers in your user
profile

Participate in an audio conference

• Join or leave the audio conference
• Switch audio connection modes
• Ask to speak
• Mute or unmute your microphone
• Use caller authentication to join the conference
• Edit or update phone numbers in your user
profile

Related Topics
About Using Personal Conferencing, on page 19
Setting Your Instant Meeting Preferences, on page 2
Allowing Another User to Schedule Meetings for You, on page 38

Connecting to an Audio Conference
Once you start or join a meeting that uses WebEx Audio, the Audio Conference dialog box appears
automatically on your screen.
What device do you want to use for speaking and listening in the meeting?
• Your phone: Typically provides good voice transmission, but may have a cost attached.
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• Your computer (with a headset, and an Internet connection): Sometimes causes noisy transmission, or
an irregular voice stream, but has no cost attached.
You can select your preferred device from the Audio Conference dialog box.

Using Your Phone to Connect to Audio
After you join a meeting, the Audio Conference dialog box appears automatically. When you use your phone
to connect to the audio portion of the meeting, you can call in or receive a call back.
• Call in—call in from your phone to a number your host provides.
• Call back—receive a call at a valid number you provide, or at a number that is already stored in your
user profile. A valid number can be an internal number or an external number that contains an area code
and seven-digit local phone number.

Note

If you join a meeting that is already in progress and shared content is all you see, select Audio on the
Meeting Controls panel at the top of your screen to access the Audio Conference dialog box.

Procedure
Step 1

To receive a call back, do one of the following in the Use Phone pane of the Audio Conference dialog box:
• Click Call Me to receive a call at the number displayed.
• Select another number from the drop-down list of available numbers, then click Call Me.
• Select Call me at a new number from the drop-down list, click on the country flag and select the
country, enter a phone number, then click Call me.
• Select Call me at an internal number from the drop-down list, enter a number, then click Call Me.

Step 2
Step 3

To call in, select I will call in from the drop-down menu in the Use Phone pane of the Audio Conference
dialog box.
Follow the instructions to join the audio conference.
A phone icon appears next to your name in the Participants list to indicate that you are using your phone in
the audio conference.

Related Topics
Switching Audio Devices During a Meeting, on page 17
Switching Audio Devices During a Meeting, on page 17
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Leaving an Audio Conference
Procedure
Step 1

Open the Audio Conference dialog box from one of the following:
• The Quick Start page
• Your Participant list
• The Audio menu
• The Meeting Controls panel (if you are sharing)

Step 2

Select Leave Audio Conference.
Your participation in the audio conference ends; however, your participation in the meeting continues until
you leave it or the host concludes it.

Using Your Computer to Connect to Audio
After you join a meeting, the Audio Conference dialog box appears automatically. When you use your
computer to speak and listen in a meeting, your computer sends and receives sound across the Internet. To
do this, your computer must have a supported sound card and be connected to the Internet.

Note

If you join a meeting that is already in progress and shared content is all you see, select Audio on the
Meeting Controls panel at the top of your screen to access the Audio Conference dialog box.

Before You Begin
Make sure that you use a computer headset with a high-quality microphone rather than speakers and a
microphone for the best audio quality and convenience.

Procedure
Step 1
Step 2

Select the arrow next to the Use Computer for Audio option.
Select Call Using Computer.
Note
If this is your first time connecting to a meeting with your computer, the Speaker/Microphone
Audio Test window appears so that you can fine tune your sound settings.
A headset icon appears next to your name in the Participants list to indicate that you are using your computer
in the audio conference. Now that you are connected to your meeting, you can do the following:
• Mute or unmute your speaker or microphone
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• Change the volume on your speaker or microphone

Related Topics
Fine-Tuning Your Microphone and Speaker Settings, on page 17
Country Code Values

Fine-Tuning Your Microphone and Speaker Settings
If you are using your computer to connect to the meeting audio, you can fine-tune your microphone and
speaker settings to optimize your audio experience.
The Speaker/Microphone Audio Test walks you through testing your devices, and setting your speaker volume
and microphone level.
When you first start or join a meeting, you can manually test and adjust your sound device before you actually
start using your computer for audio.

Tip

After you join the audio portion of the meeting you can retest your settings at any time simply by reopening
the Audio Conference dialog box and clicking Test speaker/microphone at the bottom of the box.

Procedure
Step 1
Step 2

From the meeting window, select Audio > Speaker/Microphone Audio Test.
Follow the instructions.

Switching Audio Devices During a Meeting
You can easily switch from one audio device to another during a meeting with little disruption.

Procedure
Step 1

To switch from your computer connection to a phone connection:
a) Open the Audio Conference dialog box from one of the following:
• The Quick Start page
• Your Participant list
• The Audio menu
• The Meeting Controls panel (if you are sharing)
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b) Select the down arrow beside Use Phone.
c) Call the number in the Use Phone area and enter the access code and attendee ID, as directed by the
automated operator.
After you are connected by phone, your computer connection is dropped automatically.
Step 2

To switch from your phone connection to a computer connection:
a) Open the Audio Conference dialog box from one of the following:
• The Quick Start page
• Your Participant list
• The Audio menu
• The Meeting Controls panel (if you are sharing)
b) Select the down arrow beside Use Computer for Audio.
c) Select Switch to Using Computer.
Your phone connection is dropped after your computer connection is established.
Tip

Remember to switch to your computer
headset.

Muting and Unmuting Microphones
The following table illustrates how to quickly mute and unmute microphones in your meeting depending on
your user role.
Windows users: Right-click in the Participants list, then select one of the described options.
Mac users: Ctrl + click in the Participants list, then select one of the described options.

Note

During sharing, you can mute and unmute your microphone from the Meeting Controls panel at the top
of your screen.
Role
Host

Options
• Mute on Entry to mute all microphones
automatically when participants join a meeting
• Mute or Unmute to mute or unmute your own
or a specific participant's microphone
• Mute All to mute or unmute all participant
microphones simultaneously at any time during
a meeting
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Role

Options

Participant

Select the Mute or Unmute icon to mute or unmute
your own microphone.

The microphone icon to the right of the participant's name changes state.

Editing or Updating Your Stored Phone Numbers
You can edit or update the phone numbers listed in your profile in the following circumstances:
• You have not yet joined the audio conference or
• You joined the audio conference from your computer
In addition, you can view any phone number that is stored as a cookie on your computer. Any updates you
make do not take effect until the next time you join a meeting.

Before You Begin
Make sure that you are not participating in an audio conference by phone if you want to edit or update your
phone numbers.

Procedure
Step 1

Do either of the following:
• From the meeting window, select Audio > Audio Conference.
• At the bottom of the Participants panel, select Audio.
The Audio Conference dialog box appears.

Step 2

Select Manage phone numbers from the drop-down box in the lower pane.
The Manage phone numbers dialog box appears.

Step 3

Select Edit to update the phone numbers in your WebEx profile, or Clear to delete phone numbers that are
stored as cookies on your computer.

About Using Personal Conferencing
Personal Conferencing audio connection mode lets a meeting host quickly start the audio portion of a Cisco
WebEx meeting at any time. The meeting host and participants simply dial the same call-in number, enter
access codes, and the audio portion of the meeting begins. The system then sends an email to the meeting
host with a link to the online portion of the meeting. If the host chooses to start the online meeting, participants
can then use it to share information or collaborate on an idea. The meeting host is not required to schedule
Personal Conference meetings in advance, and once generated, the access codes do not change.
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Personal Conference meetings are only available if your site supports Personal Conferencing. Before you can
have a Personal Conference meeting, you need to create a Personal Conference account and host PIN. You
can dial in to a Personal Conference meeting using either your phone or your computer.
• Phone - use the call-in numbers provided on the My Accounts page or in the email meeting invitation
to dial in to a Personal Conference meeting. To view the call-in numbers on the My Accounts page, go
to the My Audio Connection Options section and select Personal Conferencing. If the host has
scheduled the meeting, the call-in numbers are included in the email invitation sent to all invitees. The
meeting host is not required to schedule a Personal Conference meeting if all participants plan to dial
in to a meeting using a telephone.
• Computer - meeting participants can use a computer with a headset connected, if the computer has a
supported sound card and a connection to the Internet, to join the audio portion of a Personal Conference
meeting. When one or more meeting participants plan to dial in to a meeting using a computer, the
meeting host should schedule the meeting. First, meeting participants will start and join the online portion
of the scheduled Personal Conference meeting by selecting the meeting link found in the email invitation.
Once connected to the meeting, the host and participants use the information available on the Audio
Conference dialog box to connect to the audio portion of the meeting.
After joining the meeting, participants can switch between audio modes with little or no listening interruption.
In a mixed-mode conference, where some participants are using the telephone and others are using a computer,
all participants can speak.

Note

The number of people who can join a Personal Conference meeting depends on the configuration of the
system. Contact your administrator for more detailed information.
Your role in an audio conference determines your level of participation. The following table lists the basic
tasks a host and invitee can accomplish before and during a Personal Conference meeting.
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Role in Personal
Conference Meeting

Tasks

Host

Create a host PIN and Personal Conference account before starting or scheduling
your first Personal Conference meeting
Schedule a Personal Conference meeting
Dial a call-in number and enter a host access code and host PIN to start or join
a meeting
Use the phone keypad to do the following:
• *1 dial out
• *5 lock and unlock a meeting
• *6 mute or unmute self
• *7 send a reminder email to an invitee
Note

The system sends only one reminder email message to invitees,
regardless of the number of times the host presses *7.

• *8 allow the meeting to continue without the host
• ## mute all participants
• 99 unmute all participants
• *# play participant count
• ** DTMF help
After starting the online portion of a Personal Conference meeting, a host can:
• Pass the host role to another meeting participant
• Reclaim the host role from a meeting participant
• Select Record in the upper right corner of the Meetings page to record
the meeting
Invitee

Dial a call-in number and enter a participant access code to join a meeting
Use the phone keypad to do the following:
• *6 mute or unmute self
• *# play participant count
• ** DTMF help
After joining the online portion of a Personal Conference meeting, an invitee
can:
• Become a meeting host, if the host passes the host role to you
• Pass the host role to another meeting participant
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Note

If your System Administrator has enabled the Voice connection using computer option, when the web
portion of a Personal Conference meeting is started, the audio key shortcuts on all phone users' keypads
are disabled.
Related Topics
Using Your Phone to Connect to Audio, on page 15
Scheduling a Meeting from the WebEx Site, on page 33
Creating Your Personal Conference Account, on page 22
Setting Your Instant Meeting Preferences, on page 2

Creating Your Personal Conference Account
You must create a host PIN and at least one Personal Conference account before you schedule or start a
Personal Conference meeting. For each account, the software generates unique host and participant access
codes. The system prompts you for these codes after you dial a call-in number to start or join a Personal
Conference meeting.

Before You Begin
Personal Conferencing must be enabled for your site.

Procedure
Step 1
Step 2

Select My Account in the top right corner of the Meetings page.
Select Personal Conferencing in the My Audio Connection Options section.

Step 3

Enter a 4-digit host PIN and select Save PIN and Generate Account.
Account 1 host and participant access codes appears below the host PIN.
You use the same host PIN for all
accounts.
(Optional) To create another account select the Add another account link.
A new account with unique access codes displays. These access codes remain the same until you regenerate
the codes or delete the account. You can create up to three accounts.
Note

Step 4

Note

While a Personal Conference meeting is in progress, you cannot add a new account.

Related Topics
Scheduling a Meeting from the WebEx Site, on page 33
Dialing In to a Personal Conference Meeting, on page 23

Cisco WebEx Meetings Server User Guide Release 2.5
22

Selecting Audio and Meet Now Options
Dialing In to a Personal Conference Meeting

Dialing In to a Personal Conference Meeting
The meeting host and participants dial the same call-in number and enter a host or participant access code to
start a Personal Conference meeting at any time. When all participants dial in to the meeting using a phone,
the host is not required to schedule the meeting.
If a meeting participant wants to dial in to a Personal Conference meeting using a computer and a headset,
the host should schedule a Personal Conference meeting to allow the person dialing in with a computer to
join the online portion of the meeting before connecting to the audio portion of the meeting.

Note

When you dial in to a Personal Conference meeting, if you are prompted to enter your access code or
meeting number, always enter your access code.

Before You Begin
• Personal Conferencing must be enabled for your site.
• A valid host PIN and at least one Personal Conference account must exist.
• The host should know if participants plan to dial in to the Personal Conference meeting using a phone
or a computer with a headset.

Procedure
Step 1
Step 2
Step 3

Select My Account in the top right corner of the Meetings page.
Select Personal Conferencing in the My Audio Connection Options section.
Select an account.
The host PIN, and host and participant access codes display.

Step 4
Step 5
Step 6

Convey the call-in number and participant access code to meeting participants.
The meeting host dials the call-in number. When prompted, the host enters a host access code and PIN.
Meeting participants dial the same call-in number. When prompted, the participants enter a participant access
code.
If participants dial in to the meeting early, they remain on hold until the host dials the call-in number and
enters the host access code and PIN. Once the host is connected to the meeting, all participants on hold are
automatically connected to the audio portion of the meeting. If the administrator has enabled the audio option
to allow participants to join the audio portion of the meeting before the host, participants who dial in early
are immediately connected to the audio portion of the meeting after entering the participant access code.

What to Do Next
• The host can start the online portion of the meeting to share information that meeting participants can
view on their desktops. The host can start the meeting from the email invitation by selecting the meeting
link, or by selecting Start from the Meetings page after signing in to a Cisco WebEx Meetings Server
site.
• Anyone can leave the meeting by hanging up their phone or ending the call.
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• A meeting host can press *8 on the phone before hanging up to allow meeting participants to continue
the meeting without a host.
• If the meeting host simply hangs up the phone (without pressing *8 first) meeting participants can
continue the meeting for five minutes before the meeting ends.
Related Topics
Joining a Meeting From an Email, on page 28
Using Your Computer to Connect to Audio, on page 16
Leaving an Audio Conference, on page 16
Joining a Meeting From the Meetings Page, on page 29

Regenerating Access Codes
For security purposes, you can regenerate access codes.

Note

Invitees will have incorrect access codes for upcoming Personal Conference meetings scheduled with an
account that has regenerated access codes.

Procedure
Step 1
Step 2

Select My Account in the top right corner of the Meetings page.
Select Personal Conferencing in the My Audio Connection Options section.
Existing accounts are listed.

Step 3

Select Regenerate access codes.
The new access codes display for the account.
Note

While a Personal Conference meeting is in progress, you cannot regenerate access
codes.

What to Do Next
• Send an email with the new access codes to all invitees who have the old access codes.
• Consider rescheduling previously scheduled Personal Conference meetings after you regenerate access
codes for an account. When you reschedule a meeting, invitees receive updated email invitations with
valid access codes.
Related Topics
Editing a Meeting, on page 39
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Deleting a Personal Conference Account
You can delete Personal Conference accounts if you no longer need them.

Note

Invitees will have incorrect access codes for upcoming Personal Conference meetings scheduled with an
account that has been deleted. Personal Conference meetings scheduled with other accounts may also be
affected.

Procedure
Step 1
Step 2

Select My Account in the top right corner of the Meetings page.
Select Personal Conferencing in the My Audio Connection Options section.
Existing accounts are listed.

Step 3

Select Delete.
The account is removed from the list.
Note

While a Personal Conference meeting is in progress, you cannot delete an account..

What to Do Next
Consider rescheduling previously scheduled Personal Conference meetings after you delete an account. When
you reschedule a meeting, invitees receive updated email invitations with valid access codes.
Related Topics
Editing a Meeting, on page 39
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Joining a Meeting
When a meeting host schedules a meeting or starts an instant meeting by using the Meet Now option, the
host and all invitees receive an email invitation with the meetings details. When it's time to join a meeting,
invitees select the meeting URL in the email invitation or in an instant message.
• Before You Join a Meeting, page 27
• Joining a Meeting From an Email, page 28
• Joining a Meeting From the Meetings Page, page 29
• Joining By Meeting Number, page 30

Before You Join a Meeting
This section describes some of the things you might experience when you join a meeting.
The size of your system determines the maximum number of people who can join a meeting. When number
of meeting participants reaches the maximum size, users who try to start new meetings or join meetings see
an error message and the system prevents them from starting or joining a meeting. Users who dial into the
meeting hear an audio prompt indicating that he or she cannot start or join a meeting because the system has
reached the maximum participant capacity.
For any meeting, only half of the maximum number of participants can use video. Video is defined as sending
or receiving, meaning users are using their WebEx webcam video or the video file share option which allows
them to share a video.
If your WebEx site uses self-signed certificates instead of certificates from a well-known Certificate Authority,
after your data center is joined to another data center, users need to install a certificate for each data center in
the Trusted Root Certification Authorities store before they start or join a meeting.
If you are using Chrome 32 and later or Firefox 271 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.

1 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you
might be required to complete the following one-time installation to add the Cisco WebEx extension to your
Chrome browser:
1 Select Add WebEx to Chrome.
2 Select Free on the Cisco WebEx Extension dialog.
3 Select Add to add the Cisco WebEx extension to your Chrome browser.
4 Open the Cisco_WebEx_Add-on.exe file and select Run.
5 The page refreshes when the installation has finished. If the meeting does not start automatically, refresh
the page.

Joining a Meeting From an Email
Procedure
Step 1

Open your email invitation, then select the link.
The meeting details page appears for the meeting you are joining.

Step 2

If requested, enter the required information. Details you may need to enter include the following:
• Your name: Enter the name you want attendees to use to identify you during the meeting.
• Email address: Enter your email address in this format: name@your_company. For example,
msmith@company.com.
• Meeting password: Enter the meeting password. The meeting host may have included the password in
the email invitation or, for security reasons, provided it to you in another way.

Step 3

Select Join.
• If you are already signed in or do not have an account on this WebEx site, wait for the meeting client
to launch.
• If you are not signed in but you do have an account on this WebEx site, the system will redirect you to
a sign-in page where you can enter your user credentials before joining your meeting.
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Note

If your site is configured for single sign-on (SSO), the sign-in page will be on your company's
SSO site. If your site is not configured for SSO, you will sign in through the WebEx sign in
page.

What to Do Next
If you are using Chrome 32 and later or Firefox 272 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you
might be required to complete the following one-time installation to add the Cisco WebEx extension to your
Chrome browser:
1 Select Add WebEx to Chrome.
2 Select Free on the Cisco WebEx Extension dialog.
3 Select Add to add the Cisco WebEx extension to your Chrome browser.
4 Open the Cisco_WebEx_Add-on.exe file and select Run.
5 The page refreshes when the installation has finished. If the meeting does not start automatically, refresh
the page.

Joining a Meeting From the Meetings Page
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.

2 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Locate your meeting in the Today list.
If your meeting is not visible, select the All Meetings tab and enter your search parameters to locate it.
Note

Step 2
Step 3

Select Join.

What to Do Next
If you are using Chrome 32 and later or Firefox 273 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Joining By Meeting Number
You can join a meeting by using the meeting number whether you are signed in to Cisco WebEx or not.

Procedure
Complete one of the following:
If
You are already signed in to your WebEx site

Do This
1 Make sure that you are on the Meetings page by
selecting the Meetings tab.
2 Select Join by Number.
3 Enter the meeting number.
4 Enter the meeting password, if requested.
5 Select Join.

3 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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If

Do This

You are not signed in to your WebEx site

1 Open your web browser and navigate to your
WebEx site.
2 Select the Join by Number link in the top right
of the header.
3 Enter the requested information on the Join by
Number page.
4 Select Join.
Tip

You can also access the Join by Number page
by entering your public WebEx site URL
followed by /orion/join, for example,
https://<public site url>/orion/join

If you are using Chrome 32 and later or Firefox 274 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.
Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page,
check the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL
(before https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Troubleshooting Tips
If you cannot join the meeting by using the meeting number, do the following:
• Make sure that you are entering the correct meeting number.
• Make sure that it is the correct time to join the meeting.
• If your information is correct, search for the meeting on the Meetings page and try to join from the link.
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Starting or Scheduling a Meeting
• Scheduling a Meeting from the WebEx Site, page 33
• Starting a Meeting from the WebEx Site, page 35
• Starting an Instant Meeting, page 36
• Starting a Meeting From Your Instant Messenger, page 37
• Allowing Another User to Schedule Meetings for You, page 38
• Finding a Meeting, page 38
• Editing a Meeting, page 39
• Editing a Recurring Meeting, page 39
• Canceling a Meeting, page 40
• Recurrence Pattern Support , page 40

Scheduling a Meeting from the WebEx Site
Before You Begin
A host must have a license to schedule or start a WebEx meeting.

Procedure
Step 1

At the top of the Meetings page, select Schedule.
The Schedule a WebEx Meeting page appears.

Step 2

Specify the following information for your meeting:
• What: What will the meeting be about?
• When: When should the meeting take place?
To schedule a recurring meeting, select Recurrence then choose your option.
• Length: How long should the meeting be?
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• Who: Who do you want to invite to your meeting? You can type email addresses or type names to search
for in your contacts. You can also invite people later after you have scheduled the meeting.
Note
If you want to allow an invitee to have most of the same hosting privileges as you do, select
the Alternate Host option for that invitee. An alternate host can not edit or delete a meeting.
If you join the meeting after an alternate host has started it you will automatically become the
host.
Step 3

Select your audio connection type.
• WebEx Audio - This audio connection mode lets meeting hosts and participants join the online portion
of the meeting using the link provided in the meeting email invitation message. Once connected to a
meeting, users can either call in to the meeting or use the Call Me feature to receive a call at a number
they have provided. This option requires a host to schedule a meeting with either the Meet Now feature
or the scheduler.
• Personal Conferencing - This audio connection mode lets a meeting host quickly start the audio portion
of a Cisco WebEx meeting at any time. The meeting host and participants simply dial the same call-in
number, enter access codes, and the audio portion of the meeting begins. The system then sends an email
to the meeting host with a link to the online portion of the meeting. If the host chooses to start the online
meeting, participants can then use it to share information or collaborate on an idea. The meeting host is
not required to schedule Personal Conferencing meetings in advance, and once generated, the access
codes do not change.
You must have a Personal Conference account and a host PIN to use the Personal Conferencing
option.
(Optional) For a WebEx meeting, enter a Meeting Password.
Note

Step 4

• Enter a password if you want to make your meetings private. Your invitees will be required to enter the
meeting password to join the meeting unless they are already signed in to their WebEx account.
• For additional security, check Exclude password from email invitation. Excluding the password means
that it will not appear in the meeting details page or any email invitations. As the meeting host, you can
then choose to send the password specifically to your invitees and others who request it.
Step 5
Step 6

(Optional) Check Record this meeting to have the system automatically start recording when the meeting
starts.
Select Schedule It!.
The meeting details page appears with a message confirming that your meeting is scheduled.
Note
Note

The maximum meeting length is 24
hours.
The system prevents you from scheduling a meeting during a scheduled maintenance window or
when a future maintenance window is scheduled.

Related Topics
Recurrence Pattern Support , on page 40
Editing a Meeting, on page 39
Canceling a Meeting, on page 40

Cisco WebEx Meetings Server User Guide Release 2.5
34

Starting or Scheduling a Meeting
Starting a Meeting from the WebEx Site

Starting a Meeting from the WebEx Site
Before You Begin
A host must have a license to start a WebEx meeting.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Locate the meeting that you want to start.
Tip
The Start button only displays as green if you are within the acceptable time to start the meeting.
Note

Step 2

Step 3
Step 4

Select Start.
(Optional) If the meeting you are starting is part of a recurring series, confirm that you want to start the next
upcoming meeting in the series.
The meeting is started.

What to Do Next
If you are using Chrome 32 and later or Firefox 275 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you
might be required to complete the following one-time installation to add the Cisco WebEx extension to your
Chrome browser:
1 Select Add WebEx to Chrome.
2 Select Free on the Cisco WebEx Extension dialog.

5 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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3 Select Add to add the Cisco WebEx extension to your Chrome browser.
4 Open the Cisco_WebEx_Add-on.exe file and select Run.
5 The page refreshes when the installation has finished. If the meeting does not start automatically, refresh
the page.

Starting an Instant Meeting
Before You Begin
A host must have a license to start an instant WebEx meeting.

Procedure
Step 1

From the top of your Meetings page, select Meet Now.

Step 2

Enter your meeting details, including the names or email addresses of people you want to invite to your
meeting.
(Optional) If you see the Meeting Password field, do the following:

Step 3

• Check Show actual password if you want to see the password that you are entering.
• For additional security, check Exclude password from email invitation. Excluding the password means
that it will not appear in the meeting details page or any email invitations. As the meeting host, you can
then choose to send the password specifically to your invitees and others who request it.
If you don't see the password field, it's possible that you didn't set a meeting password in your account
settings or your administrator didn't configure your WebEx system to require one. If you want the
option of setting a password for your instant meetings, select My Account and enter one in the Meet
Now Settings section. You can always change the password when you set up your meeting.
Select Start.
Tip

Step 4

What to Do Next
If you are using Chrome 32 and later or Firefox 276 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

6 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Starting a Meeting From Your Instant Messenger
After you install WebEx Productivity Tools, a WebEx tab displays whenever you start a chat from your
supported instant messenger client. Select the relevant option to start a meeting or invite people to your WebEx
meeting.

Before You Begin
This release of Cisco WebEx Productivity Tools integrates with the following instant messenger clients:
• Lync 2010 (32-bit)
• Lync 2013 (32-bit)
• Microsoft Office Communicator 2007
• Microsoft Office Communicator 2007 R2
A host must have a license to start an instant WebEx meeting.

Procedure
Step 1
Step 2
Step 3
Step 4

Open your instant messenger client and select a user from the roster.
A chat window opens with a WebEx tab on the top.
To start a meeting, select the Start Meeting button on your WebEx tab.
Cisco WebEx Meetings launches.
To invite a user to your meeting, select the user from your IM roster.
A chat window opens with a WebEx tab on the top.
Select Invite to Meeting from the WebEx tab.
The meeting link is sent to the user.
Note
If you already started a WebEx meeting from another interface, such as the website or the Outlook
integration, you can still invite users from your instant messenger client by selecting them from your
IM roster and using the Invite to Meeting button.
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Allowing Another User to Schedule Meetings for You
You can grant permission to one or more users to schedule meetings on your behalf by using the Cisco Webex
Productivity Tool for Outlook. Once a user schedules a meeting for you, the meeting appears in the list of
meetings. You can then start the meeting and host it as you normally do when you schedule meetings yourself.

Before You Begin
This task assumes the following:
• The user who will be scheduling meetings for you has an account on your WebEx site.
• A host must have an installed or temporary license to schedule a meeting.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select My Account in the top right.
The My Account page appears.
Note

Step 2
Step 3
Step 4
Step 5

Scroll down to the Session Options section.
For Scheduling Permission, enter the email addresses of users you permit to schedule meetings on your behalf.
Select Update.

Finding a Meeting
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the All Meetings tab.
If a meeting has been started and ended, it will be deleted from the Meetings page. If a recording is available
for that meeting, you can find it on the Recordings page.
Note

Step 2

Step 3

Enter your search parameters.
You can search for meetings by choosing a date range, entering the host name, or topic.

Step 4

Select Search.
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The meeting list updates with your search results.

Editing a Meeting
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
Note

If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.

Step 2

Select the topic of the meeting that you want to edit.
The meeting details page appears.

Step 3

Select Edit.
The Edit WebEx meeting page appears.

Step 4
Step 5

Modify the meeting parameters.
Select a save option:
• Save and Notify All—Saves your updates and sends an updated meeting notification to all of your
invitees.
• Save Only—Saves your updates but does not send an updated meeting notification to your invitees.
The meeting details page appears with a message confirming that your meeting is updated.

Related Topics
Recurrence Pattern Support , on page 40

Editing a Recurring Meeting
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the topic of the meeting that you want to edit.
Note

Step 2
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The meeting details page appears.
Step 3
Step 4

Select Edit.
Select whether you want to edit a single occurrence of this meeting series or the entire series.
The Edit Meeting page appears.
If you make any change to a single occurrence of a meeting series, this occurrence is assigned a new
meeting ID from the server. Ensure you send an updated meeting notification, with the new meeting
ID, to all your invitees.
Modify the meeting parameters.
Select a save option:
Note

Step 5
Step 6

• Save and Notify All—Saves your updates and sends an updated meeting notification to all of your
invitees.
• Save Only—Saves your updates but does not send an updated meeting notification to your invitees.
The meeting details page appears with a message confirming that your meeting is updated.

Canceling a Meeting
You can cancel any meeting you have scheduled from the meeting details page. Canceling a meeting deletes
it from the list of meetings on the Meetings page.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Go to the meeting details page by selecting the topic for the meeting or by selecting a link from your
confirmation email message.
Note

Step 2

Recurrence Pattern Support
If you have a meeting that occurs on a regular basis, such as a monthly company meeting or weekly status
meeting, you can set it up as a recurring meeting. Scheduling a recurring meeting allows you to set up the
meeting once for the entire meeting chain.
The following table describes the supported WebEx recurrence patterns:
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Type

Description

Daily

Repeats the meeting every day until the ending date
that you select.
• Every [x] days: Repeats the meeting after the
specified number of days pass.
• Every weekday: Repeats the meeting each day,
from Monday to Friday.

Weekly

Repeats the meeting every week until the ending date
that you select.
• Every [x] week(s) on: Repeats the meeting
every specified number of weeks on the chosen
day.

Monthly

Repeats the meeting every month until the ending
date that you select.
• Day [x] of every [x] months: Specifies the
specific day of the month on which to repeat
the meeting, and the number of months that pass
before the meeting repeats.
• Every [x] of the [x] week of every [x]
month(s): Specifies the specific week and day
of the week on which to repeat the meeting, and
the number of months that pass before the
meeting repeats.

Ending

• No end : Repeats the meeting for 10 years.
• End by: Specifies the last day on which the
meeting recurs.
• After [x] meetings: Specifies the number in the
meeting series after which the meeting stops
recurring.

Related Topics
Scheduling a Meeting from the WebEx Site, on page 33
Editing a Meeting, on page 39
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Using a Mobile Device to Schedule or Join a
Meeting
Use your mobile device to schedule or join a meeting from any location. Download the Cisco WebEx app
to your mobile device and activate the service, then sign in to Cisco WebEx in the usual manner and you're
ready to schedule or attend meetings.
• Downloading Cisco WebEx Meetings on a Mobile Device, page 43
• Activating Cisco WebEx Meetings on a Mobile Device, page 44
• Signing In to WebEx Using a Mobile Device, page 44
• Starting a Meeting with a Mobile Device, page 45
• Joining a Meeting With a Mobile Device, page 45
• Installing a SSL Certificate on a Mobile Device, page 45

Downloading Cisco WebEx Meetings on a Mobile Device
Go to your Cisco WebEx site and select Downloads on the top right of the page. Navigate to the WebEx for
Mobile Devices section and select Continue. An activation email is sent to you.
• Apple iPhone or iPad: Make sure to download the app from the Apple Store using the link in your email.
Alternatively, you can launch the Apple App Store on your iPhone or iPad and search for "Cisco WebEx
Meetings". You'll find this app in the Meet Anywhere category.
• Android devices: Make sure to download the app from Google Play or the alternative link provided.

Note

Your administrator must configure the system to display the option to download WebEx for mobile devices
before you can see it on your WebEx site.
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Activating Cisco WebEx Meetings on a Mobile Device
Selecting Continue for the Cisco WebEx for Mobile Devices option on the Downloads page causes the system
to send an activation email to your account. Select the link in your activation email to complete the activation
process. If you haven't yet downloaded the WebEx app, the activation link will prompt you to download it
from the appropriate site.
• Apple iPhone or iPad: After downloading the app, return to your email and select the activation link
again.
• Android devices: Your app will launch automatically after installation. Sign in to finish the activation
process.

Note

Your administrator must have enabled the mobile feature for your organization before you can use WebEx
on your mobile device.

Signing In to WebEx Using a Mobile Device
There are several ways to sign in to WebEx depending on how your system is configured. The application
will guide you through the sign in process, but here are a few tips:
• If you get an email to activate your WebEx app, select the contained link to activate your service, then
enter the email address associated with your WebEx account and your WebEx password to sign in.
• If you're prompted to sign in through your corporate website, enter your WebEx site URL, click Next,
then enter your user credentials to sign in.

Tip

If your WebEx site is configured for single sign-on (SSO), make sure that you enter
your corporate user credentials to sign in. If your WebEx site is not configured for SSO,
enter your WebEx user credentials.

• If you have access to multiple WebEx sites, the system will prompt you to choose one after you sign in.
• To join a WebEx meeting you are invited to open the meeting invite in your email inbox or from your
Calendar app. Tap on the meeting link in that invite to launch WebEx in your web browser. Optionally,
you will be prompted to enter a meeting password. After providing your password, you will be taken to
the meeting.
Tip

If you are not signed in to the WebEx app, the option to join by meeting number is not
supported unless you have previously signed in from your mobile device.
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Starting a Meeting with a Mobile Device
As a host, you can easily schedule, start, and invite others to your WebEx meetings from your mobile device

Note

You cannot record a WebEx meeting that is scheduled or started with an iPhone or iPad.

Procedure
Step 1

Go to the My Meetings screen.

Step 2
Step 3

Select the + icon in the upper right corner of the Meeting pane.
Enter your meeting title, date and time, and then select your desired attendees.
If the meeting is starting soon, you can start your meeting from here.

Step 4
Step 5

To start a meeting, select Start.
(Optional) To schedule a meeting for later, tap Schedule. and be returned to the My Meetings screen.
The My Meetings page appears.

Joining a Meeting With a Mobile Device
Make sure that you have the Cisco WebEx Meetings app installed on your mobile device, then join your
WebEx meeting using one of the following methods:
• Go to your WebEx meeting invitation email and select the link to join the meeting.
• Sign in to your WebEx account and join from the My Meetings page.
• Sign in to your WebEx account and use the Join by Number feature by entering the meeting number.

Installing a SSL Certificate on a Mobile Device
If your company uses a self-signed certificate or if the root certificate installed on your Apple iPhone or iPad
is not on the Apple trusted Certificate Authority list, you must install a SSL certificate on your mobile device
before you join a WebEx meeting.

Before You Begin
An administrator must send you a certificate file attached to an email message.
Users must have an active high-speed Internet connection for their mobile devices.
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Procedure
Step 1
Step 2

From your iOS email account, open the email from your administrator and save the certificate file to your
mobile device.
Install the certificate on your mobile device.
a) Tap Install on the Install Profile page.
b) Tap Install Now on the Unsigned Profile dialog.
c) Enter the certificate password.
d) Tap Next.
e) Tap Done.
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Scheduling WebEx Meetings with Microsoft
Outlook
• About WebEx Integration to Outlook, page 47
• Scheduling a WebEx Meeting from Microsoft Outlook, page 48
• Starting a Scheduled Meeting from Microsoft Outlook, page 49
• Recurrence Pattern Support in WebEx Integration to Outlook, page 50
• About Delegates, page 51
• Assigning a Delegate on the WebEx Site, page 52
• Assigning a Delegate in Microsoft Outlook, page 53
• Scheduling a Meeting or an Appointment for Another Host, page 53
• Starting a Meeting for Another Host, page 54
• Editing a Scheduled Meeting, page 55
• Canceling a Meeting in Microsoft Outlook, page 56
• Joining a Meeting from Microsoft Outlook, page 56
• Joining a Meeting from the WebEx Site, page 57

About WebEx Integration to Outlook
WebEx Integration to Outlook provides a convenient way for you to schedule or start online meetings using
Microsoft Outlook. Using Integration to Outlook, you can perform these activities without the need to use
your WebEx site—that is, the site on which you normally schedule and join your online meetings.
WebEx Integration to Outlook is a WebEx Productivity Tool for Microsoft Outlook. If your administrator
has configured it, you can choose to install Productivity Tools from the Downloads link on your WebEx site.
Depending on system configuration, Productivity Tools can automatically update when new versions are
available.
Once Productivity Tools are installed, WebEx integration options appear in Microsoft Outlook allowing you
to quickly schedule an online meeting.
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Note

Before you use WebEx Integration to Outlook, ensure that:
• You have a user account on your WebEx site
• You are familiar with Microsoft Outlook
• You are using a supported version of Microsoft Outlook:
◦Microsoft Outlook 2007 SP2 and later
◦Microsoft Outlook 2010 (32-bit and 64-bit editions; all Service Packs)
When scheduling a meeting, you can invite people using any of your Outlook address lists, including the
Global Address List, Personal Address List, or Contacts folder. People whom you invite to a meeting do
not need to use Integration to Outlook to join the meeting.

Scheduling a WebEx Meeting from Microsoft Outlook
To schedule an online meeting using WebEx Integration to Outlook, open a new Meeting Request or
Appointment window in Outlook, and then specify information and settings for the meeting.

Before You Begin
Be aware of the following:
• Integration to Outlook does not support all of the recurrence options that are available in Microsoft
Outlook.
• In any meeting invitations that you send from Microsoft Outlook, the meeting's starting time appears in
the time zone that is set on your computer, not in your WebEx account preferences.
On your WebEx site, all meeting times appear in the time zone that you set in your site preferences,
regardless of the time zone that is set on your computer.
• Since you are scheduling the meeting from Microsoft Outlook, any users you invite as alternate hosts
will receive two meeting notifications:
◦one inviting them as an invitee with the Join the Meeting link
◦one inviting them as an alternate host with the Start the Meeting link
Your invitees can use either link to enter the meeting. If you schedule the meeting from the web, users
you invite as alternate hosts will receive just one email notification with a link to start the meeting.

Procedure
Step 1

From your Microsoft Outlook client, open a new meeting request by doing one of the following:
• Choose New > Meeting Request or New > Appointment.
• Select Schedule Meeting from the WebEx menu
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A Meeting scheduling window appears with the Add WebEx Meeting ball in the WebEx menu.
Step 2

Enter your meeting details, such as the meeting subject and start and end times, and invite attendees.
To specify a recurrence pattern for your meeting, click Recurrence, and then select recurrence options.

Step 3

Select Add WebEx Meeting from the WebEx menu.
The WebEx Settings dialog box appears.
If the WebEx Settings dialog box does not appear, sign in to WebEx Assistant and select the Add
WebEx Meetings icon again.
(Optional) If you want to include a password for your meeting, enter it in the Meeting Information section.
(Optional) If you want to grant other users the permission to start your meeting on your behalf, select the
Alternate Host tab and select them from the list. You must first add them to your list of attendees before
selecting them.
Select OK to close the WebEx Settings dialog box.
WebEx information displays in your Microsoft Outlook appointment form.
Note

Step 4
Step 5

Step 6
Step 7

Select Send to save your meeting information and send email invitations to invitees.
The scheduled meeting displays in your Outlook calendar and the list of meetings on your WebEx Meetings
page.

Related Topics
Recurrence Pattern Support in WebEx Integration to Outlook, on page 50
About Scheduling a Meeting for Another Host

Starting a Scheduled Meeting from Microsoft Outlook
Procedure
Step 1

In Microsoft Outlook, double-click the meeting entry from the Outlook calendar.
The meeting notification appears.

Step 2

Select the link to start your meeting.

What to Do Next
If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.
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Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Recurrence Pattern Support in WebEx Integration to Outlook
The following table shows how Outlook recurrence patterns are handled in WebEx:
Type

Outlook Option

Converted to WebEx Meeting
Option

Daily

Every [x] days

Every [x] days

Every weekday

Every weekday

Weekly

Every [x] weeks on: [Sunday,
Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday]

Every [x] weeks on: [Sunday,
Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday]

Monthly

Day [x] of every [y] months

Day [x] of every [y] months

The [first, second, third, fourth,
last] day of every month

Day [1,2,3,4,31] of every month

The [first, second, third, fourth,
last] weekday or weekend day

Not supported

The [first, second, third, fourth,
last] Sunday, Monday, Tuesday,
Wednesday, Thursday, Friday,
Saturday] of every [x] months

The [first, second, third, fourth,
last] Sunday, Monday, Tuesday,
Wednesday, Thursday, Friday,
Saturday] of every [x] months

Every [January....December]
[1,....31]

Not supported

[first, second,third, fourth, last]
[day,weekday,weekend day] of
[January....December]

Not supported

Yearly
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Type

Outlook Option

Converted to WebEx Meeting
Option

End date

No end date

No end date

End after [x] occurrences.

End after [x] occurrences. This will
convert to end by date on the page.

End by [date input]

End by [date input]

Related Topics
Scheduling a WebEx Meeting from Microsoft Outlook, on page 48

About Delegates
WebEx Integration to Outlook supports the concept of having one user, a delegate, complete scheduling
activities on behalf of another user. These activities can include scheduling, editing, canceling, and starting
meetings. For example, if you need to host WebEx meetings on a regular basis, you can give your assistant
permission to complete these activities for you by assigning this person as your delegate.
Things to Know Before Assigning a Delegate
• If you do not see the option to assign a delegate on your WebEx site, enable the Scheduling Permission
option on your My Account page.
• Your delegate must also have a WebEx host account on your WebEx site.
• The email addresses for both your and the delegates' accounts on your WebEx site must match those in
Microsoft Outlook.
• Meetings that your delegate schedules appear in your calendar. If you want to edit them, you must have
WebEx Integration to Outlook installed on your computer.
• You can remove scheduling permission from your delegate at any time.
• The Scheduling Permission option applies only to WebEx Audio meetings. Another user cannot schedule
Personal Conference meetings on your behalf.
Things to Know If You Are Assigned to Be a Delegate
Before you schedule a meeting for another host, ensure that:
• You have a WebEx host account. To obtain a WebEx host account, contact your administrator.
• The WebEx Integration to Outlook add-in is installed.
• The actual host does the following:
◦Gives you scheduling permission on the WebEx site.
◦Selects you as a delegate in Microsoft Outlook and shares his or her calendar with you.
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Note

• After scheduling a meeting on behalf of another host, you can also start the meeting for that host, if
necessary.
• At any time, the actual host can remove scheduling permission from you.

Related Topics
Assigning a Delegate on the WebEx Site, on page 52
Assigning a Delegate in Microsoft Outlook, on page 53
Scheduling a Meeting or an Appointment for Another Host, on page 53
Starting a Meeting for Another Host, on page 54

Assigning a Delegate on the WebEx Site
The following task describes how to grant scheduling permissions to your delegate on the WebEx site.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select My Account in the top right.
The My Account page appears.
Note

Step 2
Step 3
Step 4

Scroll down to the Session Options section.
For Scheduling Permission, enter the email addresses of users you are assigning as a delegate.
Note
Users must have host privileges in Cisco WebEx before you can assign them as delegates.

Step 5

Click Update.

What to Do Next
In Microsoft Outlook, select the delegate and share your calendar with him or her.
Related Topics
Assigning a Delegate in Microsoft Outlook, on page 53
About Delegates, on page 51
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Assigning a Delegate in Microsoft Outlook
The following task describes how to share your Microsoft Outlook calendar with your delegate. These steps
assume that you are using Microsoft Outlook 2010. Since the exact steps for this task may vary based on your
version of Outlook, refer to your Outlook Help documentation for details.

Before You Begin
• Make sure that you have granted scheduling permission to your delegate from your WebEx My Account
page.
• Ensure that the calendar you share does not reside in your personal folder in Microsoft Outlook. Your
delegate can access your calendar only if it resides in a public folder.
• The name of the delegate you want to assign must be in the Global Address List in your Microsoft
Outlook.

Procedure
Step 1

From Microsoft Outlook, select File > Account Settings > Delegate Access.
The Delegates window appears.

Step 2

Select Add.
The Add Users window appears.

Step 3
Step 4

Select the delegate's name, then click Add.
Click OK.
The Delegate Permissions dialog box appears.

Step 5
Step 6

For Calendar, select Editor then click OK.
Select OK to close the Options dialog box.

Related Topics
Assigning a Delegate on the WebEx Site, on page 52
About Delegates, on page 51

Scheduling a Meeting or an Appointment for Another Host
Before You Begin
This task assumes the following:
• You are a delegate of the host on whose behalf you are scheduling.
• The other host has shared his or her calendar with you.
• You are scheduling a WebEx Audio meeting on behalf of your host.
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Procedure
Step 1

Open the other host's calendar in Microsoft Outlook by doing the following:
a) Select File > Open > Other User's Folder.
The Open Other User's Folder dialog box appears.
b) Type the name of the actual host or click Name to select his or her name.
c) For Folder type, select Calendar, then click OK.
The shared calendar appears.
There are multiple ways of opening another user's calendar depending on how you customize your
views in Microsoft Outlook. For details, see the Microsoft Outlook Help.
If you are viewing multiple calendars side by side, ensure that you select the actual host's calendar by clicking
it once.
Note

Step 2
Step 3

Open a new meeting request in Outlook, and then specify information and settings for the meeting.

Related Topics
Scheduling a WebEx Meeting from Microsoft Outlook, on page 48
About Delegates, on page 51

Starting a Meeting for Another Host
Once you schedule a meeting for another host, the other host receives a confirmation email message in his or
her Microsoft Outlook. Complete this task to start the meeting from the other host's calendar.

Before You Begin
This task assumes that you have access to the other host's Microsoft Outlook calendar.

Procedure
Step 1

Open the other host's calendar in Microsoft Outlook by doing the following:
a) In Microsoft Outlook, select File > Open > Other User's Folder.
The Open Other User's Folder dialog box appears.
b) Type the name of the other host or click Name to select his or her name.
c) For Folder type, select Calendar, then click OK.
The shared calendar appears.
Note

Step 2

There are multiple ways of opening another user's calendar depending on how you customize
your views in Microsoft Outlook. For details, see the Microsoft Outlook Help.

Double-click the meeting item in the other host's calendar.
The confirmation email message appears.
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What to Do Next
To start the meeting, follow the instructions in the email message and ensure that you sign in to your own
WebEx host account on the WebEx site.
If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Editing a Scheduled Meeting
Once you schedule a meeting using WebEx Integration to Outlook, you can use Outlook to edit it at any time.
For example, you can change its starting time, specify a new password, or choose an alternate host and so on.
Once you edit a scheduled meeting, Integration to Outlook sends an updated meeting invitation to any invitees
and also updates the meeting information on your WebEx site.

Before You Begin
• If you edit a WebEx meeting from the WebEx site, your changes will not show in Microsoft Outlook.
Make sure that you use the same scheduling interface for both scheduling and editing WebEx meetings.

Procedure
Step 1
Step 2

On your Microsoft Outlook calendar, open the item for the scheduled meeting.
Edit the meeting information or change options on either the toolbar or on the Appointment tab.
For example:
• To change the WebEx meeting settings, select Change Settings.
• To remove the WebEx meeting settings previously set, select Cancel WebEx Meeting.
• To add or change a recurrence pattern, select Recurrence.
• To edit the text in the meeting invitation email message, do it on the Appointment tab.

Step 3

Do one of the following, as appropriate:
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• To send the updated meeting invitation to invited attendees and save the updated meeting in your Outlook
calendar, select Send Update.
• To save the updated meeting to your Outlook calendar, select Save and Close.
Your meeting is updated in both your Microsoft Outlook calendar and the WebEx site.

Canceling a Meeting in Microsoft Outlook
Procedure
Step 1
Step 2
Step 3
Step 4

Open the meeting item in Microsoft Outlook.
Select Delete.
Choose whether to notify invitees or not, and then click OK.
Click OK in the confirmation box.
The meeting is removed from your Outlook calendar and your WebEx site. A message appears confirming
that your meeting was removed from the site.

Joining a Meeting from Microsoft Outlook
Procedure
Step 1

In Microsoft Outlook, click the meeting entry in your Outlook calendar.
The meeting notification appears with all of the information you need to join the meeting, such as the meeting
number and meeting password if required.

Step 2

Click the link to join your meeting.

What to Do Next
If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.
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Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.

Joining a Meeting from the WebEx Site
Before You Begin
You may need the following information to join a meeting from the WebEx site:
• Meeting password—required if the meeting host scheduled the meeting with a password requirement.

Procedure
Step 1

Locate your meeting in the Today list.
Note
If you cannot find your meeting, select the All Meetings tab and do the following:
• Enter your search parameters.
• Select The meetings you are invited to from the drop-down list.
• Select Search.

Step 2

Select Join next to the meeting you want to join.

What to Do Next
If you are using Chrome 32 and later or Firefox 27 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.
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Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
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Starting or Joining a Blast Dial Meeting
The Blast Dial feature lets a meeting host start a meeting quickly with a predetermined group of people.
• Downloading the Group and Participants Templates, page 59
• Starting a Blast Dial Meeting, page 60
• Joining a Blast Dial Meeting, page 61

Downloading the Group and Participants Templates
The host of a Blast Dial group uses the links provided to download the Group and Participants templates.
Send the completed templates to the Administrator who will create your Blast Dial Group.

Important

Only the person designated as a host for a Blast Dial group should download and complete these templates.

Procedure
Step 1
Step 2
Step 3

Sign in to your WebEx site.
Select the My Account link.
In the Blast Dial Information section, select the GroupTemplate link to download the template a host uses
to provide the general settings, such as group name and host PIN, for the new Blast Dial group.
Tip
• You can leave the Route Pattern and Call-in Number fields blank. Your administrator configures
a route pattern and call-in number for each Blast Dial group..
• If you plan to start the online portion of your Blast Dial meeting, consider entering a meeting
password to provide extra security for your meeting.
• If you have a large Blast Dial group, consider selecting No Tone for the joining meeting Indicator
to provide the best meeting experience.
• The Unlimited Call Attempts option is provided for instances where it is imperative for all
participants to join a Blast Dial meeting.
• For the most secure meeting, consider having a 10-digit host PIN and participant PIN.
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Step 4

Select the ParticipantsTemplate link to download the template a host uses to provide participants' information,
such as email address, for the new Blast Dial group.
Tip
• For internal participants, meaning users who have a company email address, only a user's email
address is required.
• To make an internal participant a host who can start Blast Dial meetings, enter a 'Y' in the ISHOST
column.
• There must be at least one internal participant designated as a host for each Blast Dial group.
• For external participants, enter a first and last name, an email address, and 1-4 phone numbers.
If you do not provide a phone number for an external participant, the system does not automatically
call this participant when a host starts a Blast Dial meeting. The participant has to call into the
meeting by dialing the call-in number and entering a participant PIN.

Step 5
Step 6

Follow the instructions provided at the top of each template to fill in the required information.
Send the completed templates to the administrator who will create the Blast Dial group.

Starting a Blast Dial Meeting
Use this feature to quickly hold a meeting with a preconfigured group of users. A host can start a Blast Dial
meeting any time. After the host calls the Call-in access number and enters a host PIN, the system automatically
begins calling the members of the Participants list. For audio only Blast Dial meetings, the meeting ends when
the last person in the meeting ends the call. For online Blast Dial meetings, the meeting ends when the host
ends the online portion of the meeting.

Note

For Blast Dial online meetings the host cannot edit or delete the online portion of the meeting and
participants cannot join the meeting before the host.

Before You Begin
• You must be configured as a Blast Dial host to start a Blast Dial meeting.
• Only a host with a license can start a Blast Dial meeting.
• Hosts receive an email notification with the Call-in number and host PIN (if configured) when the
Administrator creates a Blast Dial group.
• Participants receive an email notification with the Call-in number, participant PIN (if configured) when
the Administrator creates a Blast Dial group.
• The Blast Dial Information section on your My Account page provides the Call-in number and PIN
information for each Blast Dial group in which you are a host or a participant.
• A host can call into an in-progress Blast Dial meeting and enter either a host PIN or participant PIN to
join the meeting
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Note

Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast
Dial meeting.
During the audio portion of a Blast Dial meeting you can enter the following audio key shortcuts on the keypad
of your phone or mobile device:
• *1 Dialout (host only)
• *5 Lock or unlock (host only)
• *6 mute self or unmute self
• ## Mute all participants (host only)
• 99 Unmute all participants (host only)
• *# Play participant count
• #7 End meeting (host only)
• ** DMTF help

Note

The audio key shortcuts are only available during the audio portion of the Blast Dial meeting. When the
host launches the online portion of the meeting, these actions must be completed in the meeting client.

Procedure
Step 1

A host calls the Call-in number indicated in your email notification or My Accounts page.

Step 2

Enter the host PIN.
The meeting starts immediately. The system automatically calls the list of participants for this Blast Dial group
and sends an email notification with the URL for the web portion of the meeting.
If several host are configured for a Blast Dial group, the host who calls the access number and enters
the host PIN first is the host of the meeting. The other hosts join the meeting by answering the system
generated Blast Dial call and enter the host PIN.
(Optional) Start the online portion of the meeting by selecting the URL in your email notification.
Note
Any user with host privileges can start the online portion of the meeting.
Note

Step 3
Step 4

(Optional) Enter a meeting password, if required, when you access the online portion of the meeting. This
password is provided in your email notification.

Joining a Blast Dial Meeting
The system calls participants to join a Blast Dial meeting. If participants miss the call or they want to join an
in-progress Blast Dial meeting, they dial the call-in number indicated in the email invitation and enter the
participant PIN.
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Note

Unlike other types of Cisco WebEx meetings, a Blast Dial meeting continues until the last person in the
meeting ends the call or hangs up his or her phone.

Before You Begin
• Participants receive an email notification with the call-in number, participant PIN (if required), and
meeting password (if required) when an Administrator adds you to the Participants list for a Blast Dial
group.
• The Blast Dial Information section on your My Account page provides the call-in number and PIN
information for each Blast Dial group in which you are a host or a participant.
• Only a host with a host PIN can start a Blast Dial meeting.
• Only a host can start the online portion of a Blast Dial meeting.

Note

Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast
Dial meeting. Likewise, anyone who knows the call-in number and participant PIN can join an in-progress
Blast Dial meeting.

Procedure
Step 1

Step 2
Step 3

When you answer a Blast Dial call, enter a participant PIN to join the meeting.
If you are a host but did not start the meeting, when you receive a Blast Dial call enter either the host PIN or
participant PIN to join the meeting.
You are connected to the audio portion of the meeting.
(Optional) To join the online portion of the meeting, select the URL indicated in your email notification.
Note
A host must start the online portion of the meeting before you can join
it.
(Optional) Enter a meeting password, if required.
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Managing Meeting Recordings
Meetings that you record on the server are automatically listed on the Meeting Recordings page.
Note that the recordings you see are limited to meetings you scheduled. If you are an alternate host for a
particular meeting, you will not see its recording on your Recordings page nor will the system send you an
email notification when the recording is ready even if you are the user who started the meeting or the recording.
Contact the meeting scheduler if you require a recording for any meeting that you did not schedule.
• Recording Your Meeting, page 63
• Finding a Recording, page 64
• Playing a Meeting Recording, page 64
• Downloading a Meeting Recording or WebEx Network Recording Player, page 65
• Sharing a Meeting Recording, page 66
• Deleting a Meeting Recording, page 67

Recording Your Meeting
Recording a meeting is a great way to share meeting content with invitees who could not make the meeting
or with other interested people. You can find links to the meetings you recorded on the Recordings page of
your WebEx site if you are also the meeting scheduler.

Note

You cannot start recordings for Personal Conferences unless you start the meeting from the web.

Procedure
To record your meeting, select Record located at the top right of the meeting window.
Recording begins immediately. At the end of your meeting the recording is saved to a file. Only the meeting
host has recording privileges. For information on accessing and managing your meeting recordings, see the
related topics.
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Note

You can stop and restart recording during your meeting, but doing so creates multiple recording files.
To avoid creating multiple files, simply pause and resume the recording as necessary.
If you select the Record this meeting option in the Schedule meeting page, the following applies:
• It is not supported for audio only meetings. This applies to PCN meetings and WebEx meetings
that are attended by phone users only. In order for the recording to start automatically, the host
needs to start the meeting from the web.
• If a user other than host or alternate host joins the meeting from the web before the meeting is
started from the web, the recording does not start. This is because this user does not have
recording privileges, even if they are the first attendee joining the meeting.
• If a user calls in to the meeting using a phone before the meeting is started by host from the
web, the recording does not start as you cannot start recording for an audio only meeting.

Finding a Recording
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the Recordings tab.
The Meeting Recordings page appears with the list of available recordings.
Note

Step 2
Step 3

Enter a search term and select Search.
The recording list updates with your search results.

Playing a Meeting Recording
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the Recordings tab.
The Meeting Recordings page appears with the list of available recordings.
Note

Step 2
Step 3

Locate the meeting recording that you want to access.
Tip
If the meeting list is too long, search for the recording by entering a search term in the available box
then selecting Search.
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Step 4

Do one of the following to play the recording:
• Select the topic name.
• Select the drop-down arrow in the Options column and select Play.
The recording launches in a separate window.

What to Do Next
If you are using Chrome 32 and later or Firefox 277 and later, you might see a prompt to install a Cisco WebEx
plug-in. Select Download and follow the instructions to install the required plug-in.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option, and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the playback does not start automatically, refresh the page.
If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you
might be required to complete the following one-time installation to add the Cisco WebEx extension to your
Chrome browser:
1 Select Add WebEx to Chrome.
2 Select Free on the Cisco WebEx Extension dialog.
3 Select Add to add the Cisco WebEx extension to your Chrome browser.
4 Open the Cisco_WebEx_Add-on.exe file and select Run.
5 The page refreshes when the installation has finished. If the meeting does not start automatically, refresh
the page.

Downloading a Meeting Recording or WebEx Network
Recording Player
Download a meeting recording to play it on a local device or to save it locally for future reference.

7 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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Note

If you receive notification to preserve any meeting recordings due to joining data centers, download the
recordings to your local PC.

Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the Recordings tab.
The Meeting Recordings page appears with the list of available recordings.
Note

Step 2
Step 3

Step 4

Locate the meeting recording that you want to access.
Tip
If the meeting list is too long, search for the recording by entering a search term in the available box
then selecting Search.
Select the drop-down arrow in the Options column and select Download.
WebEx prepares the recording file for download. If you have not already downloaded the WebEx Network
Recording Player, you can download it now by selecting Download Player.
You can also download the WebEx Network Recording Player from the Downloads link in the upper
right corner of your Cisco WebEx site.
(Optional) Once you download a recording, double-click the recording in the download area of the browser
to start the recording.
(Optional) To convert a recording to Windows Media Video (WMV) or Adobe Flash file (SWF), from the
Network Recording Player window select File > Convert Format and select the desired format. Complete
the fields on the Convert Format dialog.
On the original recording (either streaming or downloaded), video and audio quality is good (24+ frames per
second). After converting the recording to WMV or SWF format, you might find that the audio and video
appear to be significantly downsampled (5 Frames per second).
Tip

Step 5
Step 6

The converted file appears in the location you specified in the Save As field. Double-click the .wmv or .swf
file to play the recording.

Sharing a Meeting Recording
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the Recordings tab.
Note

Step 2

Cisco WebEx Meetings Server User Guide Release 2.5
66

Managing Meeting Recordings
Deleting a Meeting Recording

The Meeting Recordings page appears with the list of available recordings.
Step 3

Step 4
Step 5

Locate the meeting recording that you want to access.
Tip
If the meeting list is too long, search for the recording by entering a search term in the available box
then selecting Search.
Select the drop-down arrow in the Options column and select Share.
The Share Recording window appears.
Enter the requested information and select Send.
The system sends an email to the specified users with instructions on how to access the meeting recording.
Note

The system administrator can restrict meeting sharing between CWMS users
only.

Deleting a Meeting Recording
Procedure
Step 1

Sign in to your WebEx site.
The Meetings page appears.
If you are having sign in issues, make sure that cookies are enabled in your browser. You cannot sign
in to Cisco WebEx if cookies are disabled.
Select the Recordings tab.
The Meeting Recordings page appears with the list of available meeting recordings.
Note

Step 2
Step 3

Step 4
Step 5

Locate the meeting recording that you want to access.
Tip
If the meeting list is too long, search for the recording by entering a search term in the available box
then selecting Search.
Select the drop-down arrow in the Options column and select Delete.
A Delete Recording confirmation window appears.
Select OK to confirm.
The recording is deleted and a confirmation appears at the top of the Meeting Recordings page.
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Accessibility
• Using Audio CAPTCHA, page 69
• Screen Reader Support , page 70
• Supported Keyboard Shortcuts, page 70
• Working With the Participants List, page 71
• Copying Text From the Chat Panel, page 72
• Entering Text In An Input Box, page 72
• Accessing the Meeting Controls Panel During Sharing, page 73

Using Audio CAPTCHA
The CAPTCHA challenge-response test requires that you accurately enter the text that is presented into the
text box so that you can access your account. WebEx presents you with this security measure when you fail
to sign in with the correct user credentials six times or when you choose to reset your password by selecting
the Forgot your password link. As an alternative to entering what you see in the image, you can enter the
text that you hear.

Note

Audio CAPTCHA is not supported if your system is configured for SSO or LDAP authentication.

Procedure
Step 1
Step 2
Step 3

Navigate to the Hear an audio challenge link using the Tab or Shift+Tab keys and select Enter.
The text will be read to you.
Enter the text that you hear into the text box and select Enter.
To hear the text again, navigate to the Replay link using Shift+Tab and select Enter.
After entering the text correctly, you can proceed with signing in to WebEx.
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Screen Reader Support
Cisco WebEx supports JAWS screen reading software for the following elements in the meeting client:
• Application menus and drop-down menus
• Shared file titles and tab titles
• Quick Start page buttons, button titles, and tooltips
• Panel and Panels tray buttons, button titles, and tooltips
• Annotation panel and toolbars
• Shared Meeting window content area toolbars
• Meeting Controls Panel buttons, button titles, and tooltips

Supported Keyboard Shortcuts
Windows operating system participants who have special needs or who are power users can navigate around
the meeting window using keyboard shortcuts. Some of these shortcuts are standard in the Windows
environment.
Press

To

F6

Switch between meeting window areas such as the
content area and the panels area

Ctrl+Tab

• Switch between open documents in the content
area of the meeting window
• Navigate within the panels area
• Switch between tabs in the following windows:
• Invite and Remind
• Preferences
• Meeting Options
• Participant Privileges
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Press
Shift+F10

To
• Use right-click menus in the following panels
and elements:
• Participant panel
• Chat panel
• Notes panel
• Closed Captions panel
• File Transfer window
• Shared whiteboard and file tabs
• Work with the Participants list
• Copy text from the Chat panel

Tab

Switch between elements, such as buttons, fields, and
check boxes within a window or panel

Arrow keys

Switch between options in dialog boxes

Alt+F4

Close any dialog box
Note

Spacebar

Selecting Alt+F4 is just like selecting the
"x" on any dialog box.

• Check or uncheck an option box
• Enter text in an input box

Enter

Carry out the command for the active button (usually
replaces a mouse click)

Ctrl+A

Copy text from the Chat panel

Ctrl+Alt+Shift

Show the Meeting Controls panel in full-screen mode

Ctrl+Alt+Shift+H

Hiding the Meeting controls, panels, and notifications

Working With the Participants List
The Participants panel provides a right-click menu that allows you to act upon a participant depending on
your role in the meeting:
• If you are the host or presenter, you can perform actions such as making someone else the presenter or
muting another participant's microphone if it is too noisy.
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• If you are not the host or presenter, you can perform actions such as asking to become the presenter or
muting your own microphone.

Procedure
Step 1

Press F6 on your keyboard to navigate from the contents area to the Participants panel.

Step 2
Step 3
Step 4

Navigate to the appropriate participant by using the up and down arrow keys.
Select Shift+F10 to open the right-click menu on the specific participant.
Use the up and down arrow keys to navigate between the available options.

Copying Text From the Chat Panel
The Chat panel provides a right-click menu that allows you to copy text from the Chat history area.

Before You Begin
Make sure that you are in the correct portion of the meeting window by doing the following:
• Press F6 to move from the contents area to the panels area of the meeting window.
• Press Ctrl+Tab to navigate between panels until you are in the Chat panel.
• Press Tab until you are in the Chat history area.

Procedure
Step 1
Step 2

With the focus on the Chat history area, select Shift+F10 to open the right-click menu.
Use the up and down arrows to copy text or to select all text.
Tip
Alternatively, you can use Ctrl+A to select all the chat
text.
To select only a portion of the text, move your cursor with the arrow keys and then use Shift-[Arrow] to
highlight text.

Entering Text In An Input Box
Note the following tips to enter text in an input box.
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Procedure
Step 1
Step 2
Step 3
Step 4

If the window includes questions, navigate between questions using the Tab key.
If the window includes options, move between the options using the up and down arrow keys.
Move the cursor to focus on the text input area and use the Spacebar or Enter key so you can type your answer.
Press Enter or Esc to finish editing.

Accessing the Meeting Controls Panel During Sharing
During sharing, the Meeting Controls panel is partially hidden at the top of your screen. Read the following
task to display it during sharing.

Procedure
Step 1

Enter Ctrl+Alt+Shift to show the panel.
After the panel is displayed, the initial focus is on the Participants icon.

Step 2

Do the following:
Press

To

Tab

Change focus

Enter

Activate a feature

Alt+Tab

Return to the sharing area from the Meeting Controls panel
• If you are sharing a file, select the WebEx ball to return to the sharing area.
• If you are sharing an application, select the application to return focus to it.
• If you are sharing your desktop, select the application you want to share.

Note

To switch from the Meeting Controls panel to another open panel, such as the Participants list, enter
F6.
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Frequently Asked Questions
• Application and Document Sharing, page 75
• Hosting, Joining, and Setting up Meetings, page 76
• Joining a WebEx Meeting or Playing Back a Meeting Recording on Chrome and Firefox, page 78
• Cisco WebEx for Mobile Devices, page 78
• Downloading Cisco WebEx Applications, page 79
• How Do I Enable Java?, page 81
• How Do I Enable JavaScript?, page 83
• Windows OS: End-User System Requirements, page 84
• Mac OS: End-User System Requirements, page 87
• Optimizing Performance, page 87

Application and Document Sharing
Q. What's the difference between "document sharing" and "application sharing"?
A. With document sharing, attendees can see the document, but you can't change it. With application sharing,
you are sharing the application that you used to create the document so as you change the document, your
attendees see your changes. Application sharing uses more bandwidth and therefore can affect the overall
performance of your meeting.
You can share virtually any type of document or application, but those that stream video or audio may not
display properly. To share streaming content, select Share > Web Browser and follow the instructions to
display the content in a web browser on each attendee's computer. You can share many documents or
presentations at the same time; each document or presentation appears on its own tab in the content viewer.
Document sharing requires relatively little bandwidth and thus works well at slower connection speeds.
Application sharing requires more bandwidth.
Q. Can I save presentations or documents that contain annotations and view them offline?
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A. Yes. Just save the document or presentation to your desktop and then double-click it. The document or
presentation displays in the WebEx Document Viewer.
Q. Can I show animations and slide transitions in Microsoft PowerPoint presentations?
A. Yes.
Q. Why do attendees sometimes see a yellow crosshatched pattern when I share applications with them?
A. The crosshatched pattern is the shadow of a window that is displayed on top of the shared application. Just
close the window and the pattern disappears.
Q. Can I log chat to an external server?
A. No.
Q. Can I display to more than one monitor during a presentation?
A. No. You can only share to one monitor at a time.
Q. Can I use the camera on my Cisco Unified IP Phone 9971 to present video in a meeting?
A. No. Many audio endpoints support audio and video connectivity. However, only audio connectivity to the
Cisco WebEx Meetings Server is supported.

Hosting, Joining, and Setting up Meetings
Q. What do I need to host or attend meetings?
A. You must have the Cisco WebEx Meetings application. The first time you start or join a meeting, it is
automatically downloaded to your computer. You can also download the application at any time by selecting
Downloads from your WebEx site.

Note

Chrome 32 and later and Firefox 278 and later do not support Java. You will be prompted to install
the appropriate Cisco WebEx plug-in the first time you attempt to start or join a meeting, or playback
a meeting recording.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized
as of the publishing of this document.

Q. Can I schedule meetings from Microsoft Outlook?
A. Yes. You can use Outlook to schedule meetings, invite attendees, and start WebEx meetings. The attendees
you invite can join your meeting from their Outlook Calendars.
To get started, download and install Cisco WebEx Productivity Tools from your WebEx Downloads page.
8 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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For detailed instructions, see the "Scheduling WebEx Meetings with Microsoft Outlook" topic in the Cisco
WebEx Meetings Server User Guide.

Note

You must have administrative privileges to install Productivity Tools on Windows computers.

Q. Does a meeting automatically end if it exceeds the scheduled duration?
A. Regardless of the scheduled duration, a meeting can continue up to 24 hours (1440 minutes) as long as
there is a host and a participant in the meeting. When there is only one person in the meeting, a warning
message appears every 15 minutes, "You are the only participant in this meeting. The meeting will
automatically end in:". The clock decrements from 2 to 0 minutes. The user can select Continue to extend
the meeting. Unlike other types of Cisco WebEx meetings that automatically end after 24 hours, a Blast
Dial meeting continues until the last person ends his or her call or leaves the online portion of the meeting.
Q. Is it possible to restrict features?
A. Yes. If you are a System Administrator, you can enable and disable features, such as Chat, File Transfer,
and Sharing, by selecting Settings > Meetings from your Cisco WebEx Administration site.
Q. Why does a user appear twice in the meeting Participant list?
A. It is possible that the user joined the meeting from two different devices, for example, their iPhone and a
desktop computer. They might also have inadvertently joined the same meeting twice by opening Meeting
Center twice on their desktop. Ask the user to end any additional sessions so that their name displays only
once in the meeting.
Q. How many simultaneous meetings can I start as the host?
A. You can start two simultaneous meetings as the host. However, only one license is used.
Q. I would like to host a Blast Dial meeting. How do I do that?
A. SelectMy Account > Blast Dial information. Fill out the Templates as per your meeting schedule
requirements and contact your administrator.
Q. How do I know the PIN for a given blast dial meeting?
A. The host and participant PINs are sent out to hosts and participants respectively via email at the time a
Blast Dial group is created. Also, information specific to Blast Dial groups you have been invited to is
always accessible by selectingMy Account > Blast Dial information.
Q. How do I join the web meeting for a Blast Dial meeting?
A. At the time a Blast Dial meeting is launched, all hosts and participants receive an email with the link to
join the meeting as well as any associated PINs & passwords.
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Joining a WebEx Meeting or Playing Back a Meeting Recording
on Chrome and Firefox
Because of Google and Mozilla policy changes, starting with Chrome 32 and Firefox 27, it might be necessary
for users to manually enable the WebEx plug-in when using these browsers9 to join a WebEx meeting or to
play a WebEx recording. More information and instructions can be found at https://support.webex.com/webex/
meetings/en_US/chrome-firefox-join-faq.htm.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the
publishing of this document.

Cisco WebEx for Mobile Devices
Q. Why don't I see the download option for WebEx for Mobile Devices?
A. Your administrator did not configure the Cisco WebEx Meetings Server Administration site to permit the
display of this download option.
Q. Why do I see an insecure connection warning when I launch the WebEx application from my Android
device?
A. You are trying to access a site with a self-signed certificate. Select Connect to continue launching the
application.
Q. What audio conferencing is supported?
A. Integrated WebEx audio using the Internet or phone. If you do not use integrated WebEx audio, you will
need to manually dial into the audio conference or select to have the system call you at a number of your
choosing.
Q. Are there any special requirements to join the audio conference using the Internet?
A. If you are using an Android device and want to join the audio through VoIP, make sure that you are using
Android SDK 2.3 or above. VoIP on SDK 2.1 and 2.2 is not supported.
To ensure the best audio quality on the iPad, we recommend that you use a headset. Without a headset, the
application will mute you by default. To unmute yourself, tap the audio icon and select Unmute Call.

Note

Your administrator must enable the option to connect to the audio conference using the Internet
before you can use it. If you are using an iPhone or iPad, you are muted by default when you join
an audio conference using VoIP, whether or not you use a headset.

Q. Is it free to attend a Cisco WebEx meeting from my mobile device?
9 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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A. Yes, there is no cost to download Cisco WebEx Meetings for your mobile device or to attend any WebEx
meetings that you've been invited to join. If you are using a mobile data connection, note that you may
incur data connection charges though from your mobile provider as per your mobile contract.
Q. What is the video resolution on the iPad?
A.

• Portrait view (3 video screens) - 90p for each video
• Landscape view (4 video screens) - 90p for each
video
• Single active speaker - 180p
• Full Screen - 360p

Q. What is the video resolution on Android?
A. Android devices support the following:
• Up to 360p incoming video
• Up to 180p outgoing video

Q. What are the various video capabilities supported in Cisco WebEx Meetings for mobile devices?
A. The following video capabilities are supported:
• You can preview your self-video before sending to other participants.
• Video window view which enables iPhone, iPad and Android tablets to view all video enabled
participants (including self) — simply swipe left / right to view all others. For Android smartphones,
turn the phone to landscape to see the video strip and be able to swipe left / right.
• "Active-speaker" view in which participants can see who's talking as well as the content being shared
simultaneously (simultaneous video and content sharing on iPad only); the "active speaker"
picture-in-picture frame can be moved around on iPads and iPhones, not on Android devices.
• Video conferencing view in which participants can see who is talking in fullscreen mode with self-view
as picture-in-picture is supported on iPad and iPhone.

Downloading Cisco WebEx Applications
Q. Why don't I see the Productivity Tools and WebEx Meetings application on the Downloads page?
A. Your administrator has selected the Manually push WebEx desktop applications to user's desktop
option and prefers to manually push the required WebEx applications to your desktop.
Q. How can I check to see if the administrator has pushed the WebEx Productivity Tools and WebEx Meetings
application to my desktop?
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A. You will find the WebEx Productivity Tools by selecting Start > All Programs > WebEx > Productivity
Tools > WebEx Assistant. The WebEx Meetings application will be in your Control Panel (Control Panel
> Programs > Programs and Features > Cisco WebEx Meetings).
Q. What happens if I don't see the WebEx Meetings application in the Control Panel and I've been invited to
a Cisco WebEx meeting?
A. Select the join meeting link in the email invitation and follow any displayed instructions.
Q. I only see the WebEx for Mobile Devices option on the Downloads page. Why don't I see the other WebEx
applications?
A. Your administrator prefers to silently push the required WebEx applications to your desktop but is providing
access to the app for mobile devices.
Q. As an administrator, how do I configure the system to allow users to download WebEx Productivity Tools
and the WebEx Meetings application?
A. You need to select the appropriate Downloads option.
1 Sign in to the Cisco WebEx Meetings Server Administration
site.
2 Select Settings > Downloads.
3 Select Permit users to download WebEx desktop applications.
4 Select Save.

Q. As an administrator, can I determine which WebEx applications to silently push to users?
A. Yes, you need to select the appropriate Downloads option.
1 Sign in to the Cisco WebEx Meetings Server Administration site.
2 Select Settings > Downloads.
3 Select Manually push WebEx desktop applications to user's desktop.
4 Select Save.
5 Select Download for each application you want to make available to users.
When you select Download, a Windows installer ZIP file is saved to your hard drive. You can push
the .msi file to your users with Windows systems.
• WebEx Meetings application - required for users to participate in meetings.
• Productivity Tools - lets users schedule, start, and join meetings without accessing the WebEx
site, and includes the WebEx Integration to Microsoft Outlook.
• WebEx Network Recording Player - lets users download meeting recordings to convert or play
them offline.

Q. As an administrator, how do I configure the system to display the download option for WebEx for Mobile
Devices?
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A. You need to select the appropriate Downloads option.
1 Sign in to the Cisco WebEx Meetings Server Administration
site.
2 Select Settings > Mobile.
3 Select the checkboxes for the mobile devices you want to enable.
4 Select Save.

How Do I Enable Java?
• Enabling Java in the Control Panel
• Enabling Java in Your Browser (Windows)
• Enabling Java in Your Browser (Mac)

Enabling Java in the Control Panel
To ensure the best possible meeting experience, download and install the latest releases of Java software for
your supported web browser. For further assistance, contact your systems administrator.

Note

Chrome 32 and later and Firefox 27 and later do not support Java. The following information applies if
you are using a browser10 other than the ones mentioned.
*The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of
the publishing of this document.
1 Go to the Java icon to open the Java Control Panel.
2 Select the Advanced tab.
3 Expand Default Java for browsers.
4 Check the box next to one or more browser names.
5 Select Apply.
Enabling Java in Your Browser (Windows)

Note

Instructions may vary per browser version.
Internet Explorer

10 The exact versions of Chrome and Firefox that are impacted by this policy have not been finalized as of the publishing of this document.
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1 Select Tools > Internet Options.
2 Select the Security tab, then select Custom level.
3 Make sure that Scripting of Java applets is enabled.
4 Select OK to save your changes.
Firefox
1 Start Mozilla Firefox browser or restart it if it is already running.
2 Select Tools > Add-ons.
3 Select Plugins.
4 Select Java (TM) Platform.
5 Select Enable.

Note

If you see the Disable button, the plugin is already enabled.

Chrome
1 Click on the customize icon, then select Settings.
2 Select Show advanced settings .
3 Scroll down to the Privacy section, then select Content settings.
4 Scroll down to the Plug-ins section, then select Disable individual plug-ins to check whether Java is
already enabled.
5 If Java is not already enabled, select Enable.

Note

If you see the Disable link, the plugin is already enabled.

Enabling Java in Your Browser (Mac)

Note

Instructions may vary per browser version.
Safari
1 Select Safari > Preferences.
2 Select the Security tab and make sure that Allow Java is checked.
Firefox
1 Select Tools > Add-ons.
2 From the Add-ons Manager, select Plugins.
3 Select Enable for Java Applet Plug-in.
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Note

If you see the Disable button, the plugin is already enabled.

Chrome
1 Click on the customize icon, then select Settings.
2 Select Show advanced settings.
3 Scroll down to the Privacy section, then select Content settings.
4 Scroll down to the Plug-ins section, then select Disable individual plug-ins to check whether Java is
already enabled.
5 If Java is not already enabled, select Enable.

Note

If you see the Disable link, the plugin is already enabled.

How Do I Enable JavaScript?
Windows

Note

Instructions may vary per operating system and browser version.
Internet Explorer
1 Select Tools > Internet Options.
2 Select the Security tab.
3 Select Custom level.
4 Make sure Active scripting is enabled.
Firefox
1 Select Tools > Options.
2 Select the Content tab and make sure that Enable JavaScript is checked.
Chrome
1 Select the customize icon then select Settings.
2 Select Show advanced settings.
3 Scroll down to the Privacy section and select Content settings.
4 Select Allow all sites to run JavaScript or select Manage exceptions to allow your WebEx site.
5 When finished, select Done.
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Mac

Note

Instructions may vary per operating system and browser version.
Safari
1 Select Safari > Preferences.
2 Select the Security tab and make sure that Enable JavaScript is checked.
Firefox
1 Select Firefox > Preferences.
2 Select the Content tab and make sure that Enable JavaScript is checked.
Chrome
1 Select the customize icon then select Settings.
2 Select Show advanced settings.
3 Scroll down to the Privacy section and select Content settings.
4 Select Allow all sites to run JavaScript or select Manage exceptions to allow your WebEx site.
5 When finished, select Done.

Windows OS: End-User System Requirements
• Supported Windows Operating Systems
• Windows Hardware Requirements
• Tested Windows Browsers
• Microsoft Outlook Integration
• Supported Instant Messenger Clients
• Cisco Jabber for Windows Integration
Q. What are the end-user system requirements for Windows operating systems?
A. See the following sections:

Supported Windows Operating Systems
• Windows Vista (32-bit/64-bit)
• Windows 7 (32-bit/64-bit)
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• Windows 8 (32-bit/64-bit)
• Windows 8.1 (32-bit/64-bit)
Windows Hardware Requirements
Intel Core2 Duo or AMD CPU 2.XX GHz or higher processor.
A minimum of 2 GB of RAM is recommended.
Tested Windows Browsers
• Internet Explorer: 8 - 11

Note

IE 11 was tested only on Windows 7 SP1 and Windows 8.1

• Mozilla Firefox: 10 - 32 in version 2.5
Mozilla Firefox: 34 - 37 in version 2.5MR4
• Google Chrome: 23 - 37 in version 2.5
Google Chrome: 39 - 42 in version 2.5MR4
Microsoft Outlook Integration
• Microsoft Outlook 2007 SP2 and later
• Microsoft Outlook 2010 (32-bit and 64-bit editions; all service packs)
• Microsoft Outlook 2013
The following table describes which versions of Microsoft Outlook are supported on what operating systems.
Microsoft Outlook
Version (Client/
Exchange server)

Windows XP SP3

Vista

Windows 7

Windows 8
(Desktop Mode
Only)

Outlook 2007/
Exchange 2007

Y

Y

Y

N

Outlook 2010
(32-bit)/ Exchange
2007

Y

Y

Y

Y

Outlook 2010
(32-bit)/ Exchange
2010

Y

Y

Y

Y

Outlook 2010
(64-bit)/ Exchange
2007

Y

Y

Y

Y

Cisco WebEx Meetings Server User Guide Release 2.5
85

Frequently Asked Questions
Windows OS: End-User System Requirements

Microsoft Outlook
Version (Client/
Exchange server)

Windows XP SP3

Vista

Windows 7

Windows 8
(Desktop Mode
Only)

Outlook 2010
(64-bit)/ Exchange
2010

Y

Y

Y

Y

Outlook 2013/
Exchange 2010

N

N

Y

Y

Outlook 2010/
Exchange 365
Hosted

N

N

Y

Y

Outlook 2013/
Exchange 2013

N

N

Y

Y

Outlook 2013/
Exchange 365
Hosted

N

N

Y

Y

Supported Instant Messenger Clients
• Lync 2010 (32-bit)
• Lync 2013 (32-bit)
• Microsoft Office Communicator 2007
• Microsoft Office Communicator 2007 R2
The following table describes what versions of the supported instant messenger clients are supported on which
operating system.
Instant Messenger
Version

Windows XP SP3

Windows 7

Windows 8

Communicator 2007

Y

Y

Y

Communicator 2007 R2

Y

Y

Y

Lync 2010 (32-bit)

N

Y

Y

Lync 2013 (32-bit)

N

Y

Y

Cisco Jabber for Windows Integration
• Cisco Jabber for Windows 9.2.6
• Cisco Jabber for Windows 9.6.1
• Cisco Jabber for Windows 9.7
• Cisco Jabber for Windows 10.5
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• Supports Cisco WebEx Meetings Server with LDAP/Active Directory integration.

Restriction

Jabber for Windows 9.2.6 supports integration with Cisco WebEx Meetings Server 1.5 and later sites that
are configured for SAML 2.0 single sign-on (SSO). Earlier versions of Jabber for Windows do not support
single sign-on.

Not all Cisco Jabber versions or platforms support integration with Cisco WebEx Meetings Server. (For
example, cloud-based Jabber and WebEx Communicator.) For information about integrating with Cisco
WebEx Meetings Server, see the Cisco Jabber for Windows documentation at http://www.cisco.com/en/US/
products/ps12511/tsd_products_support_series_home.html.

Mac OS: End-User System Requirements
• Supported Mac Operating Systems
• Tested Mac Browsers
Q. What are the end-user system requirements for Mac operating systems?
A. See the following sections:

Supported Mac Operating Systems
• Mac OS X 10.6 Snow Leopard
• Mac OS X 10.7 Lion
• Mac OS X 10.8 Mountain Lion
• Mac OS X 10.9 Mavericks
Tested Mac Browsers
• Mozilla Firefox: 10 - 32 in version 2.5
Mozilla Firefox: 34 - 37 in version 2.5MR4
• Apple Safari: 6 and 7
• Google Chrome: 23 - 37 in version 2.5
Google Chrome: 39 - 42 in version 2.5MR4

Optimizing Performance
Q. What can I do to get the best performance?
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A. Some factors that affect performance include:
• The speed of your Internet connection
• Internet traffic between you and the Cisco WebEx Meetings Server
• The performance of any firewall and proxy servers on your network
To improve performance:
• Get the fastest internet connection possible
• Use document (presentation) sharing instead of application or desktop
sharing
• Share documents that contain fewer images
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Participants List Displays Multiple Entries for the Same User
Possible Cause This may occur because the same user signed in to the meeting from multiple devices. For

example, a user joins a meeting from home before heading into the office. The same user then joins the
meeting using his iPhone while he is in the car then joins the meeting again from his computer when he
arrives at the office. If the user forgot to end his previous session before joining through a new device,
he will be displayed in the meeting three times.
Solution Participants should end each session before joining through different devices. Maintaining duplicate

sessions for the same user will impact the available capacity of your WebEx system.

Internet Explorer Browser Not Supported
Problem You are using Microsoft Internet Explorer 8, which is supposed to be supported. However, you see

an error message stating that the browser version is not supported.
Possible Cause The browser is in Compatibility View mode, which effectively uses Internet Explorer 7

logic.
Solution Turn off compatibility view mode.

1 Open an Internet Explorer browser window.
2 Select Tools > Compatibility View Settings.
3 Verify the following:
• The WebEx site is not listed in the list of websites you've added to compatibility view.
• Display intranet sites in Compatibility View is unchecked.
• Display all websites in Compatibility View is unchecked.
4 Select Close.

404 Page Not Found Error Encountered
Problem You see a "404 page not found" error or you encounter connection problems when signing in or

joining meetings from your device running Microsoft Windows.
Solution Use the following checklist to make sure your device is properly set up to send and receive data:

• Check your network connection.
• Try using a different computer.
• Use a supported browser. Ensure that the version of Internet Explorer on your computer is 8 or later,
even if you don't intend to use IE for Cisco WebEx Meetings.
• Turn on TLS 1.0, TLS 1.2, and SSL 3.0 by accessing the Control Panel > Internet Options. Select the
Advanced tab. A list of checkboxes displays. Scroll the list to locate the Security group. Under Security,
make sure that the TLS 1.0, TLS 1.2, and SSL 3.0 checkboxes are checked.
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Cannot Start or Join Meeting
Possible Cause You are using Firefox 27 or later or Chrome 32 or later and require the Cisco WebEx

Meetings plug-in.
Solution If you see a prompt to install a Cisco WebEx plug-in, select Download and follow the instructions

to install the required plug-in.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
If you are using the Chrome 38 browser and later to start a WebEx meeting or play a WebEx recording, you
might be required to complete the following one-time installation to add the Cisco WebEx extension to your
Chrome browser:
1 Select Add WebEx to Chrome.
2 Select Free on the Cisco WebEx Extension dialog.
3 Select Add to add the Cisco WebEx extension to your Chrome browser.
4 Open the Cisco_WebEx_Add-on.exe file and select Run.
5 The page refreshes when the installation has finished. If the meeting does not start automatically, refresh
the page.
Possible Cause If you are using a browser other than Firefox or Chrome, you might not have Java installed

on your computer.
Solution Go to http://www.java.com to install Java 1.6.034 or above or Java 1.7.06 or above.

Possible Cause

• You do not have Internet Explorer (IE) 8 or 9 installed on your computer. The latest version of
Internet Explorer installed on your computer must be 8 or above, whether or not you intend to use
IE to join a WebEx meeting.
• Your systems administrator has turned on an encryption mode, and your browser is not set up to
process the encrypted data.
Solution Set up your browser appropriately. Go to Control Panel > Internet Options, select the Advanced

tab, and then ensure that TLS 1.0, TLS 1.2, and SSL 3.0 are checked. For details, see 404 Page Not Found
Error Encountered , on page 90.
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Possible Cause You are using Internet Explorer with Google Chrome Frame.
Solution Internet Explorer with Google Chrome Frame is not supported. Use a different browser that has been

tested to work with this release of Cisco WebEx Meetings Server. You can find the list of tested browsers in
the Cisco WebEx Meetings Server FAQs here: http://www.cisco.com/en/US/products/ps12732/products_user_
guide_list.html.
Possible Cause If you see the message, "Java is not working" while trying to join a WebEx meeting, your

Java SE Runtime Environment (JRE) needs to be updated to Java SE 7 Update 51 or later.
Solution On the displayed message dialog, select Click here to determine if Java is installed on your computer.

If Java is installed, close the browser and try to join a WebEx meeting again. If Java is not installed on your
computer or if the "Java is not working" message displays again, complete the following steps to download
the latest version:
1 On the displayed message dialog, select Download and install Java. This window displays http://
www.java.com/en/download/manual.jsp.
2 Select the download link that is appropriate for your computer.
3 Close your browser.
4 Open a new browser and join a WebEx meeting.
Possible Cause If a security warning message displays when you attempt to join a WebEx meeting, add

the WebEx site URL to the exception site list on the Java Security page.
Solution To add the WebEx site URL to the exception site list on the Java Security page:

1 Select Start > Control Panel > Java
2
3
4
5
6

On the Java Control Panel window, select Security.
Select Edit Site List.
In the Exception Site List section, enter the WebEx site URL and select OK.
Close your browser.
Open a new browser and join a WebEx meeting.

SSO Does Not Work with iOS Devices
Problem Single Sign-On is not working with your iOS device.
Possible Cause There is a known issue with Apple iOS 6.x, where Single Sign-On (SSO) does not work

for internal users of iPad/iPhone who are using the Safari 6 web browser. This is due to an Apple defect
that is fixed in iOS 7. The Safari bug ID is 13484525.
Solution Use a different web browser. See the "Operating System and Browser Requirements" section of the

Cisco WebEx Meetings Server Planning Guide and System Requirements for a list of supported browsers on
the Mac operating system.

Meeting Client Does Not Load
Problem I can't join a meeting because the meeting client does not load.
Possible Cause You are using Firefox or Chrome and require the Cisco WebEx Meetings plug-in.
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Solution If you see a prompt to install a Cisco WebEx plug-in, select Download and follow the instructions

to install the required plug-in.

Note

After installing the plug-in, it might be necessary to enable it.
• If you are using Chrome, select the plug-in icon that displays on the top right of your page, check
the Always allow plug-ins... option and select Done.
• If you are using Firefox, select the plug-in icon that displays at the beginning of your URL (before
https:) and select Allow and Remember.
If the meeting does not start automatically, refresh the page.
Possible Cause This may be because you are using a private CA or self-signed server certificate.
Solution Load the corresponding root certificate on your machine prior to joining a meeting.

Complete the following steps if you are using a Mac:
1 Open your Keychain Access application by selecting Applications > Utilities > Keychain Access.
2 In the left column, under Keychains, make sure that login is selected.
3 In the right column, double-click the untrusted certificate so that you can modify its information.

Note

The certificate will have an x icon next to it.
4 From the certificate window, do the following:
1 Expand the Trust section so that you can see the parameters in this section.
2 For When using this certificate, select Always Trust.
3 Enter your system account and password information.
4 Select Save Changes.
The icon next to the certificate will change from an x to a +.
Complete the following steps if you are using Internet Explorer on Windows:
1 Open the Cisco WebEx Meetings Server site in your Internet Explorer browser.
2 Select Continue to this website (not recommended).
3 Select the Certificate Error button next to the browser address bar.
4 Select View certificates.
5 In the Certificate window, select Install Certificate, then complete the following steps in the Certificate
Import Wizard:
a On the Welcome page, click Next.
b Select Place all certificates in the following store, then click Browse.
c In Select Certificate Store, select Trusted Root Certification Authorities, then click OK.
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d SelectNext, then select Finish to import the certificate.
e In the Security Warning window, select Yes to install the certificate.
f

Select OK to complete the wizard.

6 Select OK to close the Certificate window.
7 Restart Internet Explorer and reopen the Cisco WebEx Meetings Server site.

Adobe Reader Launches Automatically
Problem Adobe Reader launches automatically on the host's local computer when a PDF file is shared.
Solution This is expected behavior. Manually quit Adobe Reader and proceed to share your document.

Incorrect Version of Productivity Tools Displayed in the Control
Panel
Problem The version of Cisco WebEx Productivity Tools displayed in the About WebEx Productivity Tools

in the WebEx Assistant shows a newer version than the version displayed in the Programs and Features in
the Microsoft Windows Control Panel.
Possible Cause The administrator selected the option on the Administration site to automatically update

WebEx Productivity Tools when a new version is available.
Solution When an administrator selects the option to automatically update WebEx Productivity Tools, the

system prompts users to install an update when a new version of WebEx Productivity Tools is available. After
the installation is complete, the version of Cisco WebEx Productivity Tools displayed in the Programs and
Features in the Windows Control Panel shows the older version number. This is a known issue and will be
fixed in a later release.

Error Message: Host Access Code and Host PIN Combination
is Incorrect
Problem When I dial in to a Personal Conference meeting or connect to the online portion of the Personal

Conference meeting because I'm using a computer with a headset, I receive an error message indicating that
the host access code and host PIN combination is incorrect.
Solution Check your host PIN and host access code, and verify that you can sign in to your WebEx site:

• Go to your My Account page and select Personal Conferencing in the My Audio Connection Options
section. Verify that you are using the correct host PIN and host access code generated for the Personal
Conference account you used when you scheduled the meeting. If you regenerated access codes for an
account after you scheduled the meeting, the old host access code will not work.
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• Check to make sure that you can sign in to your WebEx site. Your user account may have been
inadvertently deactivated. If you can sign in to your WebEx site and you are using the correct host access
code and host PIN, you may want to delete the current meeting and schedule a new Personal Conference
meeting.

Error Message: Participant Access Code is Incorrect
Problem As an invitee, when I dial in to a Personal Conference meeting or connect to the online portion of

the Personal Conference meeting because I'm using a computer with a headset, I receive an error message
indicating that the participant access code I entered is incorrect.
Solution Go to your meeting email invitation and verify that you are entering the correct participant access

code. If you are entering the participant access code displayed in the email invitation, contact the meeting
host to make sure the code has not changed since the host scheduled the meeting. If the host regenerated access
codes after scheduling the meeting, the host may have to cancel the current meeting and schedule a new
Personal Conference meeting.

Error Message: We've Hit a Glitch Processing Your Request
Problem When I attempt to add or delete a Personal Conference account or regenerate Personal Conference

access codes, I receive the error, "We've hit a glitch processing your request. Try again a little later."
Possible Cause There may be a network issue or the back-end connection failed.
Solution Wait a few minutes and try to add or delete an account or regenerate access codes again. If you see

the same error, contact your administrator for assistance

Error Message When Regenerating Access Codes
Problem I'm trying to regenerate access codes for a Personal Conference account but I receive an error message.
Solution If you are hosting a Personal Conference meeting and the meeting is in progress, wait until the meeting

has ended and try again. If you do not have a Personal Conference meeting in progress, and the system does
not regenerate the access codes for an account, there may be a network issue. Contact your administrator for
assistance.

Error When Deleting a Personal Conference Account
Problem I'm trying to delete a Personal Conference account but I receive an error message.
Solution If you are hosting a Personal Conference meeting and the meeting is in progress, wait until the meeting

has ended and try again.If you do not have a Personal Conference meeting in progress, and the system does
not delete an account, there may be a network issue. Contact your administrator for assistance.
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Invitees Do Not Receive Reminder Email Messages
Problem As a meeting host, when I press *7 on the phone keypad, invitees do not receive reminder email

messages for my Personal Conference meeting.
Solution The *7 function works only when you schedule a Personal Conference meeting and include invitees

in the Who field on the Schedule a WebEx Meeting page. If you did not schedule the Personal Conference
meeting using your WebEx site or the WebEx Assistant, the *7 function will not send email reminders to
invitees.

Cannot Join a Personal Conference Meeting
Problem When I dial in to a Personal Conference meeting and enter the meeting number, I'm not connected

to the meeting.
Possible Cause Although the phone prompts you to enter a Participant Access code or a meeting number,

you should enter only the Participant Access code to access a Personal Conference meeting. The meeting
number is used for WebEx Audio calls.
Solution Hang up your phone and try to dial in to the Personal Conference meeting again, but enter the

Participant Access code.

Cannot Install WebEx Productivity Tools
Possible Cause Your computer may lack administrative privileges to perform the installation.
Solution Contact your administrators for more information.

"Remember Me" Function Does Not Work
Problem I selected Remember Me on the sign-in page, but I still had to reenter my information when signing

in the next time.
Possible Cause Cookies in your browser might be turned off.
Solution First, ensure that you are using a supported browser. You can find them listed in the FAQs at http://

www.cisco.com/en/US/products/ps12732/products_user_guide_list.html. Then turn on cookies in your browser.
For help in doing so, contact your system administrator.
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Cannot Record Meeting
Problem The Record button is grayed out so I cannot record my WebEx meeting.
Possible Cause

• You scheduled the WebEx meeting using an Apple iPhone or iPad.
• The WebEx meeting was started by a person using an Apple iPhone or iPad.
Solution

• Continue with your meeting even though it is not being recorded. Video, audio and desktop sharing
features will operate properly.
• Ask all participants to leave the WebEx meeting, then cancel the meeting and use your computer to
schedule a replacement meeting. Start the new meeting from your computer, then select the Record
button to begin recording your meeting.

Note

If you use your computer to schedule and start a WebEx meeting, you can record the meeting even if
invitees join the meeting using a mobile device.

Cannot Play a Meeting Recording
Problem When I receive an email message with a link to a WebEx meeting recording, I select the link to play

the recording but receive an error message.
Possible Cause The administrator has selected a configuration setting that requires users to be signed in

to a WebEx site to play a meeting recording.
Solution Sign in to a WebEx site. Then select the link to the recording in the WebEx meeting recording email

you received.

Experiencing Audio or Video Issues During Meetings
Problem You hear constant background noise or buzzing sounds.
Possible Cause Your device may be experiencing a network bandwidth issue.
Solution If you are on 3G, try switching to Wi-Fi if it is available.
Problem You cannot hear the speaker.
Possible Cause The microphone or speaker setting on your headset may not be properly adjusted.
Solution If you are using a headset, see Fine-Tuning Your Microphone and Speaker Settings, on page 17 for

more information about adjusting your headset settings.
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Problem If you are using video, you see a noticeable delay in the audio.
Possible Cause Other applications are using a lot of system resources, for example if you are downloading

a large file.
Solution If you are downloading a large file, you may want to cancel the download job and restart it after the

meeting.
Problem A speaker hears an echo of what he is saying.
Possible Cause If your device has an earpiece, audio may be coming out of the earpiece instead of the

speaker.
Solution Plug in a headset for better audio quality.
Problem The video for other participants cannot load or freezes.
Possible Cause Your device may not have adequate memory.
Solution If you are using a computer, it needs at least 2 GB of RAM.
Problem You cannot send your video.
Possible Cause If you cannot send video, another application may be already occupying your device's

camera.
Solution If you have other applications running in the background, you may want to close them.
Problem You cannot hear audio through your Bluetooth headset.
Possible Cause Not all Bluetooth headsets are supported, depending on the platform of your mobile device.
Solution Contact your administrator for help.

Deleting Meetings Scheduled By a Deactivated User
Problem I have meetings displaying on my calendar that were scheduled by a user who is no longer with the

organization.
Possible Cause When users leave an organization, they are deactivated from the Cisco WebEx system.

Since meeting schedulers are the only users who can cancel their own meetings, any meetings they
scheduled before they were deactivated remain in the system and cannot be canceled.
Solution Manually delete the meeting entries from your calendar.

Web Presentation Pauses
Problem I am using dual monitors to share content during a web conference. When I turn on my webcam video

in full-screen mode on one of my screens, my presentation automatically pauses on the other screen and
participants are unable to see the changes I make in my presentation.
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Possible Cause Cisco WebEx Meetings does not support video in full-screen mode while you are also

presenting content during a web conference.
Solution Minimize your video to resume your presentation.

Cannot Access Help
Problem The links for the Help content don't seem to work.
Possible Cause This may be due to a connection issue.
Solution Try to open the link from another web browser. If the link still does not open, check whether or not

you can visit Internet sites outside your internal network. If your network is restricted to internal sites, contact
your administrator to define a customized link for your organization's Cisco WebEx help content.
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